
PIPELINE 4 USER'S GUIDE 

JULY 2007 

This publication was produced for review by the U.S. Agency for International Development. It was prepared by the 
USAID | DELIVER PROJECT, Task Order 1. 





PIPELINE 4 USER'S GUIDE 


The authors' views expressed in this publication do not necessarily reflect the views of the U.S. Agency for 
International Development or the United States Government. 



USAID | DELIVER PROJECT, Task Order 1 
The USAID | DELIVER PROJECT, Task Order 1, is funded by the U.S. Agency for International Development 
under contract no. GPO-I-01-06-00007-00, beginning September 29, 2006. Task Order 1 is implemented by John 
Snow, Inc., in collaboration with PATH, Crown Agents Consultancy, Inc., Abt Associates, Fuel Logistics Group 
(Pty) Ltd., UPS Supply Chain Solutions, Family Health International, The Manoff Group, and 3i Infotech. The project 
improves essential health commodity supply chains by strengthening logistics management information systems, 
streamlining distribution systems, identifying financial resources for procurement and supply chain operations, and 
enhancing forecasting and procurement planning. The project also encourages policymakers and donors to support 
logistics as a critical factor in the overall success of their health care mandates. 

Recommended Citation 
USAID | DELIVER PROJECT, Task Order 1. 2007. PipeLine 4 User's Guide. Arlington, Va.: USAID | DELIVER 
PROJECT, Task Order 1. 

Abstract 
The pipeline monitoring and procurement planning system (PipeLine) is a software tool that helps program managers— 

• gather critical forecasting information 

• ensure that products arrive on time 

• maintain consistent stock levels at the program or national level 

• prevent stockouts. 

This guide provides basic information on how to use PipeLine.  
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CONVENTIONS 

Introduction 
This table lists conventions used in this manual. The list is provided to help make the manual  
easier to understand. 

CONVENTION MEANING 

< > Identifies keyboard keys (i.e., <Enter>, <Esc>, <F10>, <Alt>, <Ctrl>, 
<Back Space>, etc.). 

� Note 

Identifies points of importance. 

Helpful Hint 

Identifies points that can speed up or ease an operation. 

!! Important 

Indicates points you must consider before taking any action. 

Warning 

Indicates actions that will permanently change the data, or adversely 
effect the system. 

Italic Print Words that need special attention. 
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1 OVERVIEW 

Introduction 
The Pipeline Monitoring and Procurement Planning System (PipeLine), a software tool, was designed 
to help program managers monitor the status of their product pipelines and product procurement 
plans. PipeLine provides information needed to initiate and follow-up actions to ensure the 
regular and consistent stock of products at the program or national level. Consistency of stock is 
the first step in meeting the basic objective of any logistics system, which is to provide— 

• the right quantities 

• of the right commodities  

•	 in the right condition 
•	 in the right place 
•	 at the right time 
• for the right cost. 

These are the six rights of logistics management. 

What PipeLine Can Do for You 
PipeLine helps you achieve the right quantities at the right time. 

For each product, PipeLine monitors— 

1.	 Total quantities consumed (i.e., amounts dispensed to users or sold to clients) 

2.	 Shipments of new products (planned, ordered, shipped, or received) into your program 
and the values of your products 

3.	 Inventory levels for each product in your program's logistics system (desired and actual) 

4.	 Inventory level changes (e.g., product losses or transfers out of or into your program) 

With these data and an understanding of the lead time required for each step in the procurement 
process, PipeLine can— 

1.	 Show what actions you need to take for procurement planning and management, and 
when these actions should be taken. 
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2.	 Identify impending problems (i.e., surpluses, shortfalls, or stockouts) before they occur. 

3.	 Calculate procurement quantities needed to keep your pipeline in balance. 

4.	 Calculate the estimated value of shipments or maintain the actual value (if known). 

You can use this information with program policymakers, product suppliers, and donors to 
provide a rational basis for planning future product needs. 

PipeLine is not the answer to every logistics question. It helps monitor the aggregate quantity of 
each product entering and leaving your program's distribution system (preferably using data from 
a logistics management information system [LMIS]). 

PipeLine's utility is enhanced if your program has a well-functioning LMIS and forecasting 
procedures. Even without these underlying systems, use PipeLine with whatever data are 
available. By beginning a rational and systematic product monitoring and planning process, you 
take the first step toward ensuring consistent stock levels. 

Why Use PipeLine? 
Ensuring adequate supplies of commodities is difficult for most programs. As a program 
manager, you face a complex procurement planning environment, characterized by— 

1.	 Multiple suppliers of many products (local and private suppliers, bilateral and multi-
lateral donors, etc.), each with its own products, lead times, costs, information needs, and 
bureaucratic constraints 

2.	 Proliferation of service delivery points, in many cases in an integrated service delivery setting, 
and/or with multiple service delivery organizations served by a single logistics system 

3.	 Increasing volume (and costs) of commodities, which must be managed and moved 
through complex distribution channels 

4.	 Increasing emphasis on accountability, cost-effectiveness, and sustainability from donors 
who fund product procurement and from policymakers. 

You need to monitor the quantity and timing of multiple products entering your logistics system 
from multiple suppliers. Because procurement lead times may be long—years, in many cases— 
you need to take action months or years before commodities are needed to receive them on time. 
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You may need to negotiate with many different suppliers and donors to obtain the quantities you 
require. Such negotiations are best accomplished when specific data on product requirements are 
available. You must know when you will stock out of each product, how much must be procured 
to meet future needs, and when you should receive it. To prevent overordering, you must also 
know what quantities would exceed your storage capacity or risk wastage due to expiry. 

PipeLine can provide this information. 

Who Should Use PipeLine? 
In a multi-product, multi-supplier environment, procurement planning and pipeline monitoring 
functions cannot be donor driven. It is increasingly necessary that local program managers be 
empowered to do their own forecasting, pipeline monitoring, and procurement planning; they 
must also take charge of coordinating the activities of donors and local suppliers, as well as those 
of their own logistics management staff. Donor staff often have other priorities and little time to 
devote to the details of logistics management. Commercial suppliers have interests that may or 
may not correspond to the interests of your organization. 

If you are the logistics manager or program manager for your organization, you should manage 
your own pipeline. PipeLine can help. 

While your managers and decision makers will be the primary users of PipeLine, the system can 
provide information to— 

Suppliers of commodities 
PipeLine provides reports on the current status and the cost of pending shipments from a 
specific supplier, which that supplier can use to monitor product flow. 

Purchasers/donors of commodities 
Staff who finance the purchase of commodities can use PipeLine reports and graphs to 
understand the current pipeline status and future requirements. 

Host-country policymakers 
PipeLine reports and graphs can be used to help policymakers understand issues with the levels of 
particular commodities and the implications of different decisions on the availability of the 
product. 

PipeLine Software Functions 
PipeLine can help you with pipeline monitoring and procurement planning functions, as 
explained below. 
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Pipeline Monitoring 
Pipeline monitoring functions include— 

•	 Monitoring stock balances, in terms of quantities and months of stock on hand in the 
entire program (aggregate of stock at all levels) 

•	 Comparing stock balances to maximum and minimum stock policies 

•	 Automating the identification of pipeline problems (quantities needed, stockouts, 
balances below minimum or above maximum) 

•	 Providing couple-years of protection (CYP) conversion graphs. 

Procurement Planning 
Procurement planning functions include— 

•	 Calculation of shortfalls/surpluses and quantities needed to maintain the program’s 
desired stock levels 

•	 Automated calculation and tracking of pending pipeline actions, based on lead times 
(shipments to plan, order, ship, and receive) 

•	 Application of USAID’s contraceptive procurement tables (CPT) format for the 
computation of calendar year quantities required and the generation of data for 
USAID’s planning requirements 

•	 Calculation of estimated costs of shipments and freight 

•	 Comparison of alternative procurement scenarios and analysis 

•	 Alternative unit of measure calculation displays products in Basic Units. Basic Units 
are used to quantify patient or consumer needs and usually refers to tablets, capsules, 
or milliliters, rather than packs or bottles.  
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How to Obtain PipeLine 
PipeLine was first developed by the Family Planning Logistics Management project. It is 
now maintained by the USAID | DELIVER PROJECT, Task Order 1, and is funded by the 
U.S. Agency for International Development under contract no. GPO-I-01-06-00007-00, 
beginning September 29, 2006. Task Order 1 is implemented by John Snow, Inc., in 
collaboration with the Program for Appropriate Technology in Health, Crown Agents 
Consultancy, Inc., Abt Associates, Fuel Logistics Group (Pty) Ltd., UPS Supply Chain 
Solutions, Family Health International, Manoff Group, Inc., and 3i Infotech. The project 
improves essential health commodity supply chains by strengthening logistics management 
information systems, streamlining distribution systems, identifying financial resources for 
procurement and supply chain operation, and enhancing forecasting and procurement 
planning. The project encourages policymakers and donors to support logistics as a critical 
factor in the overall success of their health care mandates. 

The PipeLine software, its documentation, and assistance in installation and use are available 
from the following sources: 

PipeLine Product Manager 

USAID | DELIVER PROJECT 

John Snow, Inc.

1616 Fort Myer Drive, 11th Floor 

Arlington, VA 22209 USA 


Phone: 703-528-7474 

Fax: 703-528-7480 
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2 GETTING STARTED 

Introduction 
PipeLine now allows you to monitor and procure more than contraceptives. You can use it to 
monitor and procure commodities for a variety of public health purposes. This can be done with 
PipeLine’s new classification feature. 

This section explains how to install PipeLine and presents some of its new features. For 
questions about running PipeLine, contact the PipeLine Product Manager at this address: 

USAID | DELIVER PROJECT 

John Snow, Inc. 

1616 Fort Myer Drive, 11th Floor 

Arlington, VA 22209 USA 


Phone: 703-528-7474 

Fax: 703-528-7480 


System Requirements 
The following resources are recommended for use with PipeLine— 

CPU Pentium III or higher 

Operating System Windows 2000/XP 

Memory 256 MB 

Hard Drive Space 500 MB 

Video Adapter SVGA with 800x600 resolution 

Miscellaneous Microsoft Office 2003 Service Pack 2 

Although PipeLine will run without Microsoft Office® 2003 installed� on your computer, having Office 2003 installed will enhance 
PipeLine’s usefulness by allowing PipeLine to export data files to 
Word® or Excel®. 
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How to Install PipeLine 
PipeLine can be installed from a CD-ROM or the Internet. 

Before You Begin 

You can run PipeLine 2 and PipeLine 4. on the same computer, but we recommend that you 
uninstall PipeLine 2 BEFORE installing PipeLine 4. 

All other previous versions of PipeLine cannot be run on the same � computer as PipeLine 4.  When you install PipeLine 4, the installer will 
automatically remove the previous version of PipeLine prior to installing 
PipeLine 4. 

To uninstall PipeLine 2— 

1. Click on Start. 

2. Click on the Settings option. 

3. Click on the Control Panel option. 

After the Control Panel window opens— 

4. Click on the Add/Remove Programs option. 

Locate and click on PipeLine in the Currently Installed Programs list. 

5. Click on the Change/Remove button. 

The PipeLine 2 setup program will start, and will prepare your computer to uninstall PipeLine 2. 

6. Click on the Remove All Button. 

A message is displayed asking if you want to remove PipeLine. 

7. Click on the Yes button to begin the uninstall procedure. 

� Data files created with previous versions of PipeLine are not removed 
from your system. See Converting Your Existing Data Files on page 2-5 
for information on converting your existing PipeLine 2 data files. 

When the uninstall procedure is completed, you will be prompted to restart windows. 
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8. Click on the Restart Windows button. 

Installing PipeLine from a CD 
1. Start Microsoft Windows. 

2. Insert the PipeLine CD. 

The PipeLine installation should begin automatically. 

3. Follow the on-screen instructions. 

4. If the installation does not begin automatically— 

a. 	 Click on Start on the Windows Taskbar. 

b. Click on Run from the pop-up menu. 

c. 	 In the Command Line box, type x:setup ("x" is the letter of your CD-ROM 
drive). 

d. Click on the OK button, and follow the on-screen instructions. 

After PipeLine is successfully installed, the PipeLine shortcut (shown at right) 
will be displayed on your desktop. 

Installing PipeLine from the Internet 
PipeLine is available on the USAID | DELIVER PROJECT website at the following web address: 

http://deliver.jsi.com. 

� If your Internet connection is slow and/or unreliable, order the 
PipeLine CD-ROM. 

To download PipeLine— 

1. Access the Internet, and enter the USAID | DELIVER PROJECT web address. 

2. Locate the PipeLine download page, and follow the on-screen instructions to 
download PipeLine. 

� The Internet copy of PipeLine requires a password to begin the install 
process. The password will be sent by email. You must have a valid 
email address to receive the password. 

2-3 
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How to Start PipeLine 
PipeLine can be started from the Windows desktop or the Windows taskbar. 

Starting PipeLine from the Windows desktop 
From the Windows desktop— 

1. Locate and double-click on the PipeLine icon to start the application. 

Starting PipeLine from the Windows taskbar 
From the Windows taskbar— 

1. Click on Start. 

2. Click on Programs. 

3. Locate and click on the PipeLine 4.0 link. 

Reinstalling PipeLine 
To reinstall PipeLine— 

1. Place the PipeLine CD in your CD-ROM drive. 

If you do not have the PipeLine CD, you can use the copy of PipeLine you downloaded from the 
USAID | DELIVER PROJECT website. 

The Internet version of PipeLine requires a password to start the install � process. That password was sent to you by email when you downloaded 
PipeLine. If you no longer have the email containing the PipeLine password, 
redownload PipeLine from the USAID | DELIVER PROJECT  website: 
(http://deliver.jsi.com). 

2. Start the install process, and follow the instructions on your screen. 

During the process, a message box is displayed instructing you to remove PipeLine from your computer. 
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2 GETTING STARTED 

3. Click on the Remove button to remove PipeLine from your computer. 

4. Click on the Finish button when prompted. 

After PipeLine has been removed— 

5. Repeat the PipeLine installation procedure. 

See page 2-3 for information on installing PipeLine. 

Converting Your Existing Data Files 
This version of PipeLine allows you to convert data created with previous versions of PipeLine. 

From the Program Data screen— 

1. Click on the File Menu Bar option, and select the Open option from the pull-down menu. 

PipeLine opens a window so you can locate the data you need to convert. 

2. Locate and select the data file you need, and click on the Open button. 

� PipeLine files have the data file extension .mdb 

After you select the data file you need to convert, PipeLine displays a message similar to the one 
in the text box below. 

The current program’s data file is not the current version. You can 
allow PipeLine to upgrade the file now. If you do not, some of 
PipeLine’s features may not work properly. 

3. Click on the Yes button to convert the selected data. 

PipeLine opens a window, and allows you to rename the file you selected to upgrade. This 
safeguards the original data by saving the upgraded data under a different name. 

4. Type the new name in the File Name field, and click on the Open button. 

PipeLine converts the selected data, renames the file, and displays its associated program data on 
the Program Data screen. You can now work with the converted data file. 

� Remember, your original data remains in its original directory with its 
original name. The converted data is a copy of the original. 
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On-Line Help 
PipeLine’s On-Line Help is a supplement to the PipeLine 4 User's Guide. On-Line Help 
provides information about basic PipeLine functions. 

1. Press the <F1> key to access On-Line Help. 

Navigation Features 
PipeLine has navigation features that help you move easily and quickly from one part of the 
system to another. These features are the Tree View and the Menu Bar’s Window utility. 

Tree View 
This feature offers a quick way to navigate through the system. The Tree View is fully 
expanded when you start PipeLine, and it remains open on the left side of the screen. Figure 
2-1 shows an example of the Tree View. 

� The Tree View cannot be closed. 

To use the Tree View— 

1. Click on the option you need, to display its 
associated screen. 

To collapse a group of Tree View options— 

2. Click on the “-” next to a Tree View option to 
collapse the option and hide its sub-options. 

To expand a group of Tree View options— 

3. Click on the “+” next to a Tree View option to Figure 2-1—The Tree View 

expand and show its sub-options. 

Menu Bar 
PipeLine’s Menu Bar provides access to utilities and features that enhance the system's 
functionality. See appendix A, PipeLine Utilities, for information on these features and utilities. 
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PipeLine’s Window Utility 
The PipeLine Window utility enables you to 

quickly view a list of programs that are 

currently open. It also allows you to switch 

between open programs. Figure 2-2 shows an Figure 2-2—Window options      

example of the Window drop-down menu. 


To switch between open programs— 

1. Click on the Window option of the Menu Bar. 

2. Click on the name of any program file listed in the drop-down menu. 

PipeLine displays the Program Data screen, which shows the data associated with the 
selected program. 

Buttons 
The following buttons are most commonly used in PipeLine: 

BUTTON ACTION 

Adds a new record to the database. 

Copies a record. 

Deletes a selected record from the database. 

Prints a PipeLine report or graph. 

Saves a new or updated record. 

Displays a preview of the data of a graph or report before printing. 

Displays data associated with a particular report on-screen. 

Hides the data of a particular report. 

Saves the graph or report as a PDF file. 

Scroll Bars 
Vertical and horizontal scroll bars are displayed on some PipeLine screens if there is more data 
than your screen can display at one time. 
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1. Click on one of the arrow buttons to move in the indicated direction: 

Left Up 
Right Down 

Figure 2-3 displays an example of vertical and horizontal scroll bars. 

Figure 2-3—Vertical and horizontal scroll bars    

To quickly scroll through a screen, click on the square 
button on the horizontal or vertical scroll bar, and hold 
down the left mouse button, while moving your mouse left 
and right or up and down. 

Pull-Down Menus 
Pull-down menus let you choose from a list. To use a pull-down menu— 

1. Click on the arrow next to the menu to display its list. 

2. Click on the item you want to select. 

The selected item is displayed in the associated field. Figure 
2-4 shows that “DFID” was selected from the Supplier pull-
down menu. Figure 2-4—Pull-down menu     

You can also select an item from a pull-down menu by 
clicking on the menu and typing the first letter of the item 
you need. 
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Keys for Editing Records 
The following table lists keys you can use when editing records in PipeLine. 

KEYS FOR EDITING PIPELINE RECORDS 

F1 Displays On-Line Help. 

Backspace Deletes selection or character to the left of the cursor. 

Delete Deletes selection or character to the right of the cursor. 

Esc First press: Undoes changes to a field. 

Second press: Undoes all changes to the record. 

Insert Toggles between insert and overwrite modes. 

Tab Moves the cursor from one field to the next, and moves the 
cursor from one button to another without activating buttons. 
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Accessing the Program Data Screen 
After you install PipeLine and click on the PipeLine icon, the Program Data screen is displayed. 

PipeLine has a sample program database called “Ministry of Global Health,” which shows how 
PipeLine displays and organizes data. The sample database is displayed on PipeLine’s initial 
startup (see Figure 3-1). 

Figure 3-1—Program Data screen        

Adding a Program 
The File option of the PipeLine Menu Bar enables you to add a program to PipeLine. To add a 
new program— 

1. Click on the File Menu Bar option. 
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2. Click on the New option of the File drop-down-menu. 

PipeLine displays a blank Program Data screen similar to Figure 3-2. 

Figure 3-2—Blank Program Data screen       

The Program Name, ISO Country Code, Report Display Name, and � Program Code fields are required. The remaining fields are optional or 
may retain their default values. 

3. Click in the Program Name field, and type the new program’s name. 

4. Click in the Program Contact field, and type the name of the program’s contact person. 

5. Click on the pull-down menu arrow in the ISO Country Code field. Scroll down to find 
the country, click on the country to select. The Report Display Name will be 
automatically filled in. 

6. Click in the Telephone field, and type the contact person’s telephone number. 

7. Click in the Fax field, and type the contact person’s fax number. 

8. Click in the Email field, and type the contact person’s email address. 


The Program Code field holds the program’s identification code. This ten-character code must be unique.


9. Click in the Program Code field, and type the program’s code. 
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PipeLine supports English, Spanish, French, Arabic, and Portuguese. The Language field enables 
you to set the default language for the program you are creating. 

PipeLine's default language is English; all PipeLine’s screens and messages are initially 
displayed in English. To change the default language of the new program— 

10.Click on the arrow next to the language field and select the program’s default 
language from the pull-down menu. 

The selected language is used when the associated program is active. To � temporarily change the language of an active program, select Language 
from the Tools option on the Menu Bar. However, after you exit and 
restart PipeLine, the system will revert to the program’s selected default 
language. 

Default Lead Times 
Program default lead times are used to calculate procurement actions for needed 
quantities. They are also used for shipments from suppliers without lead times entered 
and without shipment lead time dates entered. 

The Plan to Order field shows the estimated lead time (in months) expected from the time 
a shipment is planned to when it is ordered. The default is 6.00 (six-month lead time). To 
change the default— 

11. Click in the Plan to Order field, delete the default value, and type the lead time. 

The Order to Ship field shows the estimated lead time (in months) expected from the time 
a shipment is ordered to when it is shipped. The default is 4.00 (four-month lead time). 
To change the default— 

12.Click in the Order to Ship field, delete the default value, and type the order to 
ship lead time. 

The Ship to Receive field shows the estimated lead time (in months) from the time a 
shipment is shipped to when it is received by the program. The default is 2.00 (two-
month lead time). To change the default— 

13.Click in the Ship to Receive field, delete the default value, and type the ship to 
receive lead time. 

Default Freight Cost 
The Default Freight Cost field shows the approximate freight cost for a shipment as a 
percentage of the shipment’s product value. Include all costs associated with product 
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delivery (i.e., taxes, clearance fees, etc.). PipeLine uses the default freight cost when 
calculating freight cost if you do not fill in freight cost estimates for individual suppliers. 

14.Click in the Default Freight Cost field, and type the default freight cost as a 
percentage of the shipment’s product value. 

The Note field is a memo field for additional information about the program, which you 
may want to store for future reference. 

15.Click in the Note field, and type any relevant notes. 

Saving the Data 
After you complete the Program Data form— 

1. Click on the Save button. 

PipeLine displays the Save Database File window so you can save the current program. 
PipeLine creates the program's default file name based on the program code. 

2. Click on the Save button to accept the default file name. 

Or, type a new file name and click on the Save button. 

Never save the data to your A:\ drive. 

The Program Data form is redisplayed after the data is saved. 

Selecting a Program 
PipeLine allows you to deselect the current program and activate another. When the Program 
Data form is displayed, it displays information about the current (active) program. You can 
activate another program if additional programs exist, as explained below. 

� The active program is the current program. The program's name is 
displayed on PipeLine screens, reports, and graphs. Only one program 
can be active at a time. 
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Opening and Activating a Program 
The Open option in the drop-down menu of the File Menu Bar option enables you to select 
and open a program, which will make the selected program the current or active program. To 
open and activate a program— 

1. Click on the File Menu Bar option. 

2. Click on the Open option on the drop-down menu. 

PipeLine displays a window showing the programs available for activation. 

Never open a program from your A:\ drive. Move the data from 
the A:\ drive to your hard disk, then use the Open option to select 
the program. 

3. Click on the program you need to open, then click on the Open button. 

Program information associated with the selected file is displayed on the Program Data screen. 

Switching between Programs 
Although you can only have one program active at a time, PipeLine “remembers” the 
previous programs you worked with. The program names are kept in a pull-down menu, 
allowing you to switch between them. 

To switch between programs— 

1. Click on the Window option of the PipeLine Menu Bar. 

2. Click on any of the programs listed in the drop-down menu. 

Program information associated with the selected program is displayed on the Program Data 
screen. This program becomes the current or active program. 

Editing Program Data 
You can edit program data for a selected program at any time. If the program you need to edit is 
not the current program— 

1. Select the program you need to edit using one the methods in Selecting a Program 
beginning on page 3-4. 

After the program you need to edit is displayed on the Program Data screen— 

2. Highlight each field you need to edit and enter the new data. 

3-5 



PIPELINE 4 USER'S GUIDE 

3. Click on the Save button when you finish. 

The data is saved and redisplayed on your screen. 

Copying a Program 
The Copy option of the File option of the PipeLine Menu Bar allows you to make a copy of the 
current program. The copy can only be saved to your hard disk. Use this option to archive the data. 

This feature can also be used to backup your program data. 

If the program you need to save is not the current program— 

1. Select the program you need to copy using one of the methods in Selecting a 
Program beginning on page 3-4. 

With the current program you need to save displayed on the Program Data screen— 

2. Click on the File option of the PipeLine Menu bar. 

3. Click on the Copy option in the File drop-down menu. 

PipeLine displays a window so that you can select where the copy will be stored. 

Never save the data to your A:\ drive. 

4. Select the location where you want to store the copy. 

5. Click on the Open button to save the data to the selected location. 

The data is saved. 

Closing a Program 
Use the Close option of the File Menu Bar option to close any open program. 

Closing a program removes it from the open program list. You can reopen any closed program

by following the instructions in Opening and Activating a Program on page 3-5. 


To close a program— 


1. Select the program you want to close. 
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2. Click on the File option of the PipeLine Menu Bar. 

3. Click on the Close option of the File drop-down menu.  

PipeLine displays a message window so you can confirm that you want the selected  
program closed. 

4. Click on the Yes button to close the selected program. 
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Introduction 
The Background Data Tree View options enable you to modify pull-down menus, program and 
supplier lead times, and product costs; and to establish product minimum/maximum stock levels. 
PipeLine has default records you can modify. If the PipeLine defaults are not right for your 
program, delete the defaults and add new records. 

Products, Categories, and Types 
A product is a commodity whose supply status you monitor. Previous versions of PipeLine let 
you classify products by method. Now you can include groups within groups by assigning each 
product to a category and assigning these categories to other categories. 

Each product is assigned to a Type, which is a category with products assigned to it. A product 
can only be assigned to one Type. After you define categories and assign products to Types, you 
can limit the products included in reports and pull-down menus. 

Products 
The Products Tree View option 
enables you to modify product 
data; and change min/max stock 
levels, a default product supplier, 
or a product's category  
or type. 

1. Click on the Products Tree 
View option. 

PipeLine opens the Products screen 
(see Figure 4-1). 

Figure 4-1—Products screen     
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Adding a Product 
Use the Add button to add a product. To add/update products from a file generated by an 
external procurement system see the PipeLine Utilities-Import Product Data section. 

With the Products screen displayed— 

1. Click on the Add button to display a blank Products screen (see Figure 4-2). 

Figure 4-2—Products screen data entry area 

2. Type the product name. 

The Code field holds the product's code, which is used to help identify the product. Data in 

the Code field is created based on the name you give the product. 


You may keep the PipeLine-generated code or use your own coding system. 


To change the PipeLine-generated code— 


3. Highlight the PipeLine-generated code, and type the new code. 

� You are limited to 10 characters, which can be numbers, letters, spaces, 
or a combination of these. 

The Default Qty per Case field shows the default product amount in a single case.  

4. Click on the Default Qty per Case field, and type the default product amount of a 
single case. 

The Default Supplier field shows the product's default supplier. 

5. Click on the arrow next to the Default Supplier field, and select the product's 
default supplier from the pull-down menu. 
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� If the supplier you need is not listed, you must add it. See Adding a 
Supplier on page 4-15. 

Type refers to the group to which a product belongs (for example, contraceptives, HIV/AIDS 
test kits, etc.). It can also refer to a category of similar products (for example, sexually 
transmitted infection [STI] treatment drugs). 

6. Click on the arrow next to the Type field, and select the type (category) from the  
pull-down menu. 

� If the type (category) you need is not listed, you must add it. See Adding 
a Category on page 4-11. 

The Active field shows that the product is active. New products are active by default. 

Months of Stock Tab 
These fields enable you to set the product's minimum, maximum, and desired stock levels. 

Program (all levels) 
This area enables you to set stock levels for the entire program. 

The Min field shows the minimum amount of stock (in months). The default is 6 
(six months of stock). To change the default— 

7. Click on the Min field, and type the product's minimum stock level. 

The Max field shows the maximum amount of stock (in months). The default is 12 
(twelve months of stock). To change the default— 

8. Click on the Max field, and type the product's maximum stock level. 

The Desired field shows the desired amount of stock (in months). The default is 12 
(twelve months of stock). To change the default— 

9. Click on the Desired field, and type the product's desired stock level. 

Central Level 
This area enables you to set the stock level for your central facility. 

The Min field shows the minimum amount of stock (in months). The default is 6 
(six months of stock). To change the default— 

10.Click on the Min field, and type the product's minimum stock level. 
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The Max field shows the maximum amount of stock (in months). The default is 12 
(twelve months of stock). To change the default— 

11.Click on the Max field, and type the product's maximum stock level. 

The Note Tab 
The Note Tab opens a memo field that enables you to enter additional information about 
the product. 

12.Click on the Note Tab, and enter any additional information about the product. 

Availability/UOM Tab 
These fields enable you to set the product’s availability, pack size, and basic unit of measure. 

Figure 4-3—Products screen Availability/UOM tab    

13.Click on the Availability/UOM tab. 

The Permitted in Country field shows whether the product is permitted in the county. The 
default is False. To change the default— 

14.Click on the Permitted in Country field. 

� If Permitted in Country is unchecked, then the product is either not 
permitted in the country or its permission is unknown. 

The Available from SCMS field shows whether the product is available for procurement 
from SCMS. The default is False. To change the default— 

15.Click on the Available from SCMS field. 

The Pack Size field shows the product’s quantity of basic units per pack. The default is 1 
(one unit per pack). To change the default— 

16. Click on the Pack Size field, and type the product’s quantity of basic units per pack. 

The Basic Unit (BU) field shows the product’s basic unit of measure. 
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17. Click on the Basic Unit (BU) field, and type the product’s basic unit of measure. 

The Availability Note is a memo field that holds information about the product’s 

availability.


18.Click on the Availability Note field, and enter any information about the 

availability of the product. 


Preference Note Tab 
The Preference Note Tab opens a memo field that enables you to enter information about 
product preferences. 

19.Click on the Preference Note Tab, and enter any information about product 
preference. 

When you finish— 

20. Click on the Save button to save the data, and return to the Products Selection form. 

See Adding Case Size Data on page 4-6 for information about entering product case size data. 

See Adding Cost Data on page 4-9 for information about entering product cost data. 

Editing Product Data 
Existing product data can be edited, as explained below.  

� If the product was imported from the SCMS product list, only a few 
fields can be edited. 

With the Products screen displayed— 

1. Click on the product in the Product window that you want to edit. 

Data associated with the selected product is displayed in the lower half of the Products screen. 

2. Click on the field you want to edit, and enter the new data. 

3. If the product is no longer active, click on the Active field. 

� A product should be marked inactive if you no longer monitor or procure 
it (i.e., a discontinued product). 
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4. Click on the Note Tab, and enter the reason for the edit. 

5. Click on the Save button to save the data. 

Deleting a Product 
Use the Delete button to delete a product. 

With the Products screen displayed— 

1. Select the product you want to delete. 

2. Click on the Delete button. 

If the product can be deleted, PipeLine will display a confirmation message. 

3. Click on Yes to confirm the delete. 

If you cannot delete the product (because it is associated with other records), PipeLine will 
display a message window. 

4. Click on OK to close the message window. 

Case Sizes 
Case sizes are used to set a product's case size for a specific supplier. Shipment quantities are 
rounded up to the nearest case. 

� Default Case Size, shown on the products screen, will be used if the case 
size is not entered for a specific supplier. 

Adding Case Size Data 
Use the Case Sizes option of the Tree View to access case size data. 

!! When adding Case Size records, you must first select the supplier and 
product from the pull-down menus. 

1. Click on the Case Sizes Tree View option. 
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The Product Case Sizes screen is displayed (see Figure 4-4). 

Figure 4-4—Case Sizes screen      

2. Click on the arrow next to the Supplier field, and select the supplier from the pull-
down menu. 

3. Click on the arrow next to the Product field, and select the product from the pull-
down menu. 

4. Click on the Add button. 

The Effective Date field displays the date the case size becomes active. For a new product, 
the default Effective Date is the system date. Shipment amounts are calculated based on the 
active case size on the shipment's order date. The last case size entered remains active until 
a new case size with a later effective date is entered. 

5. Type the date the case size becomes effective. 
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The Qty per Case field shows the product amount in a single case from the selected 
supplier. 

6. Type the product amount of a single case. 

The Note field is a memo field that holds additional information about the case size. 

7. Type any notes about the case size, if needed. 

8. Click on the Save button when you finish adding case size data. 

Editing Case Size Data 
Use the Case Sizes Tree View option to access case size data. 

1. Click on the Case Sizes Tree View option. 

2. Click on the arrow next to the Supplier field, and select the supplier from the pull-
down menu. 

3. Click on the arrow next to the Product field, and select the product you want to 
edit from the pull-down menu. 

4. Select the case size data you need to edit. 

5. Click in the field you need to edit, and enter the new data. 

6. Click on the Save button to save your changes. 

Deleting Case Size Data 

Use the Case Sizes Tree View option to access case size data. 

1. Click on the arrow next to the Supplier field, and select the supplier from the pull-
down menu. 

2. Click on the arrow next to the Product field, and from the pull-down menu, select 
the product with the case size data you want to delete. 

3. Click on the case size data you want to delete. 

4. Click on the Delete button. 

A confirmation message is displayed. 

5. Click on Yes to delete the selected case size data. 
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Costs 
Product costs are used to set a product's default cost. 

Adding Cost Data 
Use the Costs Tree View option to access the Costs screen. 

1. Click on the Costs Tree View option. 

!! When you add product cost data, first select the supplier and product 
from the pull-down menus. 

PipeLine displays cost records for the selected supplier/product, if such data exists (see Figure 4-5). 

Figure 4-5—Costs screen 

2. Click on the arrow next to the Supplier field, and select the supplier from the pull-
down menu. 

3. Click on the arrow next to the Product field, and select the product from the pull-
down menu. 

4. Click on the Add button. 
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The Effective Date field shows the date on which the cost becomes active. Shipment costs 
are calculated based on the active cost on the ship date. The amount entered remains active 
until a new amount, with a later effective date, is entered. 

5. Type the date when the new cost becomes effective. 

The Per Unit Cost field shows the product's unit cost. For the Cost reports to calculate 
complete costs, all products from each supplier must have cost data entered in this field and 
have an effective date prior to the shipment's ship date. 

6. Click in the Per Unit Cost field, and type the product's per unit cost. 

The Note field is a memo field for additional information about the product's cost. 

7. Enter any relevant notes about the cost, if needed. 

8. Click on the Save button. 

Editing Cost Data 
Cost data can be edited, as explained below. 

1. Click on the Costs Tree View option. 

2. Click on the arrow next to the Supplier field, and select the supplier from the pull-
down menu. 

3. 	 Click on the arrow next to the Product field, and select a product from the pull-down 
menu. 

Data associated with the selected product and supplier are displayed. 

4. Select the cost data you want to edit. 

5. Click in the field you need to edit, and enter the new data. 

6. Enter any relevant notes in the Note field about the changes made. 

7. Click on the Save button to save your changes. 

Deleting Cost Data 
Cost data can be deleted, as explained below. 

1. Click on the arrow next to the Supplier field, and select the supplier from the pull-
down menu. 

2. Select the product with the cost data you need to delete. 
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Data associated with the selected product and supplier is displayed. 

3. Select the cost record you need to delete, and click on the Delete button. 

A confirmation message is displayed. 

4. Click on Yes to delete the selected record. 

Categories 
Category refers to a group of related products (i.e., contraceptives, HIV/AIDS test kits, malaria 
drugs, etc.). It can also be used to categorize similar products (e.g., sexually transmitted infection 
treatment drugs). Use the Categories Tree View option to access Category data. 

1. Click on the Categories Tree View option. 

The Categories screen is displayed. See Figure 4-6. 

Figure 4-6—Categories screen    

Adding a Category 
Use the Add button to add a new category. 

With the Categories screen displayed— 
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1. Click on the Add button. 

PipeLine blanks out the data 
entry area of the Categories 
screen as shown in Figure 4-7. 

2. Type the category name. 

The Code field holds the 
category's code, which is used 
to help identify the category. Data in the Code field is created based on the name you give 
the category. 

You may keep the PipeLine-generated code or use your own coding system. 

To change the PipeLine-generated code— 

3. Highlight the PipeLine-generated code, and type the new code. 

Figure 4-7—Categories screen data entry area     

� You are limited to 10 characters, which can be numbers, letters, spaces, 
or a combination of these. 

The Parent Category field identifies the primary group to which the new category belongs. 

4. Click on the arrow next to the Parent Category field, and select an appropriate 
category from the pull-down menu. 

The Method field allows you to associate the new category with a CYP Factor. 

A CYP factor is the couple-years of protection. The CYP factor is the fraction of a year of 
protection provided by one unit of a particular contraceptive product. The CYP factor field 
can only be used if the category you are creating has been designated a Method. 

5. Click on the Method field if you want to designate the category as a method. 

6. Type the CYP factor. 

The Note field is a memo field for additional information about the new category. 

7. Type any relevant notes in the Note field. 

When you finish adding category data— 

8. Click on the Save button to save the data. 
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Editing Category Data 
Use the Categories Tree View option to edit the category data. 

With the Categories screen displayed— 

1. Select the category you want to edit. 

2. Click in the field you want to edit, and enter the new data. 

When you finish editing— 

3. Enter any relevant notes in the Note field about the changes made. 

4. Click on the Save button to save the changes. 

Deleting a Category 
Use the Delete button to delete a category. 

With the Categories screen displayed— 

1. Click on the category you want to delete. 

2. Click on the Delete button. 

If the category can be deleted, PipeLine will display a confirmation message. 

3. Click on Yes to confirm the delete. 

If you cannot delete the category (because it is associated with other database records), 
PipeLine will display a message window. 

4. Click on OK to close the message window. 

Viewing Category Relationships 
The View Categories option of the Tree View enables you to view all existing categories and 
their relationships (if any). 

1. Click on the View Categories option of the Tree View. 
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All existing categories and types are listed. See Figure 4-8. 

Figure 4-8—View Categories screen     

� Categories designated as types in product records are displayed with an 
asterisk (*). 

Suppliers 
Use the Suppliers option 
of the Tree View to 
modify the Supplier pull-down 
menu, change shipment lead times 
by supplier, and to estimate 
shipping costs by supplier. 

1. Click on the Suppliers Tree  
View option. 

Pipeline displays the Suppliers 
screen. See Figure 4-9. 

Figure 4-9—Suppliers screen     
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Adding a Supplier 
Use the Add button to add a supplier. 

With the Supplier screen displayed— 

1. Click on the Add button. 

PipeLine blanks out the lower half of the Suppliers screen (see Figure 4-10). 

Figure 4-10—Suppliers screen data entry area 

2. Click in the Supplier field, and type the supplier's name. 

The Code field holds the supplier's code, which identifies the supplier. Data in the Code 

field is created based on the name you give the supplier. 


You may keep the PipeLine-generated code or use your own coding system. 


To change the PipeLine-generated code— 


3. Highlight the PipeLine-generated code, and type the new code. 

� You are limited to 10 characters, which can be numbers, letters, spaces, 
or a combination of these. 

The Freight Cost field shows the approximate freight cost for a shipment as a percentage of 
the shipment's value. If you do not fill in this field, PipeLine uses the program's default 
freight cost. 

4. Click in the Freight Cost field, and type the freight cost percentage. 

The Default field shows that the supplier is the default supplier for your program. PipeLine 
chooses the default for a product when no supplier is specified. 

5. Click in the Default field if the new supplier will be your default supplier. 
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Lead Times Tab 
The Plan to Order field shows the estimated lead time (in months) expected from the time 
a shipment is planned to when it is ordered. The default is 6.00 (six-month lead time). To 
change the default— 

6. Click on the Plan to Order field, and type the plan to order lead time. 

The Order to Ship field shows the estimated lead time (in months) expected from the time 
a shipment is ordered to when it is shipped. The default is 4.00 (four-month lead time). 
To change the default— 

7. Click on the Order to Ship field, and type the order to ship lead time. 

The Ship to Receive field shows the estimated number of months expected from the time 
a shipment is shipped until it is received. The default is 2.00 (two-month lead time). To 
change the default— 

8. Click on the Ship to Receive field, and type the ship to receive lead time. 

The Note Tab 
Use the Note Tab to add a memo about the supplier. 

9. Click on the Note tab, and type any relevant note about the new supplier. 

10.Click on the Save button to save your data. 

Editing Supplier Data 
With the Suppliers screen displayed— 

1. Select the supplier you want to edit. 

2. Click in the field you want to edit, and enter the new data. 

3. Click on the Note tab, and type the reason for the edit. 

4. Click on the Save button to save your changes. 

Deleting a Supplier 
Use the Delete button to delete a supplier. 

With the Suppliers screen displayed— 
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1. Select the supplier you want to delete, and click on the Delete button. 

If the supplier can be deleted, PipeLine will display a confirmation message. 

2. Click on Yes to confirm the delete. 

If you cannot delete the supplier (because it is associated with other database records), 
PipeLine will display a message window. 

3. Click on OK to close the message window. 

Data Sources 
The Data Sources option of the Tree View enables you to indicate sources from which pipeline 
data is gathered. Data Source records are grouped as follows: 

• Actual Consumption—sources for actual consumption records 
• Forecast Consumption—sources for forecast consumption records 
• Stock—sources for stock records, including stock count and adjustment 
• Shipments—sources for shipment records. 

1. Click on the Data Sources Tree View option to access the Data Sources screen. 

PipeLine displays the Data Sources screen (see Figure 4-11). 

Figure 4-11—Data Sources screen    
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Adding a Data Source Option 
Use the Add button to add a new data source option. 

1. Click on the arrow next to the Data Sources For field, and from the pull-down 
menu, select the data source group where you want to add a new option. 

2. Click on the Add button. 

PipeLine blanks out the 
lower half of the Data 
Sources screen (see Figure 
4-12). 

Figure 4-12—Data Sources screen data entry area 
3. Type the source 

name. 

The Code field holds the code for the data source's code, which identifies the data source 

option. Data in the Code field is created based on the name you give the data source option. 


You may keep the PipeLine-generated code, or use your own coding system. 


To change the PipeLine-generated code— 


4. Highlight the PipeLine-generated code, and type the new code. 

� You are limited to 10 characters, which can be numbers, letters, spaces, or 
a combination of these. 

5. Click on the Save button to save the data. 

Editing Data Source Options 
You can edit Data Sources information as described below. 

With the Data Sources screen displayed— 

1. Click on the arrow next to the Data Sources For field, and select the data source 
group from the pull-down menu. 

2. Click on the data source option you need to edit. 

3. Click in the field you need to edit, and type the new data. 

4. Click on the Save button to save the changes. 
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Deleting a Data Source Option 
Use the Delete button to delete a data source option. 

With the Data Sources screen displayed— 

1. Click on the arrow next to the Data Sources field, and from the pull-down menu, 
select the data source group with the information you want to delete. 

2. Click on the data source option you need to delete. 

3. Click on the Delete button. 

If the data source option can be deleted, PipeLine will display a confirmation. 

4. Click on Yes to confirm the delete. 

If you cannot delete the data source option (because it is associated with other database 
records), PipeLine will display a message window. 

5. Click on OK to close the message window. 
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Introduction 
The Commodities Data option helps you track the movement of stock within your pipeline. 
Stock movements are events that change the stock quantity of a product in a program’s entire 
logistics system. Stock movements belong to one of the following categories: 

•	 Consumption—stock dispensed by the program to clients 

•	 Shipments—stock received by the program from suppliers 

•	 Stock—amount of product on hand, expressed in two ways: 

•	 Stock count—physical inventory of stock on hand within the entire program. 

•	 Stock adjustments—events or transactions that change the stock on hand within 
the entire program (i.e., loss of expired stock, transfers to or from another 
program, and others). 

� PipeLine does not track a transfer or distribution of stock within the 
program. These movements must be recorded in the program’s logistics 
management information system. 

Consumption 
Use the Consumption Tree View option to track actual or forecast consumption quantities of 
products dispensed to users, or sold by the program to clients. 

•	 Actual Consumption—reported or estimated quantities of product that left the 
program’s logistics system through normal dispense to clients activities. 

•	 Forecast Consumption—quantities expected to be dispensed in the future. 

1. Click on the Consumption Tree View option. 

PipeLine displays the Consumption screen (see Figure 5-1). 
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Figure 5-1—Consumption screen     

Adding Consumption Data 
To add consumption data from a file generated by an external forecasting system, see 
PipeLine Utilities – Import Consumption Data section.  Use the Add button to add 
consumption data for a particular product. 

With the Consumption screen displayed— 

1. Click on the arrow next to the Category field, and select a category from the pull-
down menu. 

2. Click on the arrow next to the Product field, and select the product you want to 
add consumption data to. 

3. Click on the Add button. 

PipeLine blanks out the lower half of the Consumption screen (see Figure 5-2). 

Figure 5-2—Consumption screen data entry area        
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Beginning In 
This area enables you to set the consumption period, which can be any number  

of months. 


The Year field shows the calendar year when the consumption period begins. 

4. Type the four-digit year. 

The Month field shows the month that marks the start of the consumption period. For 
example, “1” shows that the first month of the year is the start of the consumption period. 

5. Click in the Month field, and type the month when the consumption period 
begins. 

For the Next 
The For the Next Months field shows the number of consecutive months in the 
consumption period. For example, “3” indicates a period of three months (one quarter). 

6. Click in the For the Next Months field, and type the length of the consumption 
period (in months). 

The Actual field shows that the consumption data comes from an actual source (for example, 
physical inventory records, dispense logs, etc.). 

7. Click on the Actual field if the consumption data comes from an actual source. 

The Forecast field shows that the consumption data is an estimated projection. 

8. Click on the Forecast field if the consumption data comes from a forecast 
estimate. 

The Data Source field shows the type of data used to compute consumption. 

9. Click on the arrow next to the Data Source field, and select a data source from 
the pull-down menu. 

The Amount field shows the amount of consumption for this period. To calculate 
consumption for reports and graphs, this amount is divided by the number in the For the Next 
Months field. 

10.Click in the Amount field, and type the consumption amount. 
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� Total BUs (Basic Units) Total consumption Basic Units (BUs) are 
displayed. This is your consumption amount converted to basic units.  
(Pack times pack size.) 

The Note field is a memo area used to include additional information about the data. 

11.Click on the Note field, and type any relevant notes about the consumption data. 

The Display Note field tells PipeLine to include the note in PipeLine reports. 

12.Click on the Display Note field to include the note in reports. 

13.Click on the Save button to save the data. 

Editing Consumption Data 
Consumption data for a particular product can be edited. 

With the Consumption screen displayed— 

1. Select the Category for the product you want to edit. 

If you do not recall the name of the category for the product 
you need to edit, select All Categories from the Category pull-
down menu to access all the products in your program. 

2. Click on the arrow next to the Product field, and select the product you need to 
edit from the pull-down menu. 

3. Click on the consumption data you need to edit. 

4. Click in the field you need to edit, and type the new data. 

5. Click on the Save button to save the data. 

Deleting Consumption Data 
Use the Delete button to delete the consumption data for a particular product. 

With the Consumption screen displayed— 

1. Click on the Category field, and select the category from the pull-down menu. 

5-4 



5 COMMODITIES DATA 

2. Click on the arrow next to the Product field, and select the product that you need 
to delete consumption data from. 

3. Click on the consumption data you need to delete. 

4. Click on the Delete button, and a confirmation is displayed. 

5. Click on Yes to delete the selected consumption data. 

Shipments 
Use the Shipment Tree View option to add, modify and delete shipping data. 

1. Click on the Shipments Tree View option to display the Shipments screen (see Figure 5-3). 

Figure 5-3—Shipments screen 

Adding Shipment Data 
Use the Add button to add shipment data to a particular product. 

With the Shipments screen displayed— 

1. Click on the arrow next to the Category field, and select the category from the 
pull-down menu. 

2. Click on the arrow next to the Product field, and from the pull-down menu, select 
the product receiving the shipment data. 

3. Click on the Add button. 
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PipeLine blanks out the lower half of the Shipment screen (see Figure 5-4).  The Supplier 
values will drop down (not shown), and the Status field will display a default value of “Planned.” 

Figure 5-4—Shipments screen data entry area 

4. Select the shipment’s supplier from the pull-down menu. 

5. Click in the Quantity field, and type the shipment quantity (in units). 

The ID field uniquely identifies the shipment. You can use the NEWVERN shipment 
number, a purchase order number, an invoice number, or any other unique identifier. You can 
also accept the PipeLine-generated code. 

To enter a code of your choice— 

6. Click in the ID field, and type the shipment ID. 

The Data Source field shows the data source associated with the shipment record. 

7. Click on the arrow next to the Data Source field, and select the data source from 
the pull-down menu. 

The Status field shows the shipment’s status. The default value for this field is Planned. To 
change the default value— 

8. Click on the arrow next to the Status field, and select the shipment status from 
the pull-down menu. 

The Receive Date field shows the date the shipment was or is expected to be received. 
Each shipment record must have a receipt date.  
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9. Click in the Receive Date field, and type the shipment’s receipt date. 

After entering a value in the Receive Date field, depending on the quantity entered and the 
background product information, a message window be displayed, which notes that the 
quantity entered does not reflect the Product/Supplier case size.  PipeLine will prompt you to 
round the value to the nearest Product/Supplier case size. Select “Yes” or “No.” 

Shipment Data Tab 
The Shipment Data tab displays the shipment’s actual or estimated lead times, and the 
shipment and freight cost. 

Order (actual/estimated) 
The top field shows the actual date the shipment was or is to be ordered. The 
Estimated field is calculated based on lead times for the supplier. To override the 
estimate— 

10.Click on the top field, and type the shipment’s order date. 

Ship (actual/estimated) 
The top field shows the date the shipment was or is to be shipped. The Estimated field 
is calculated based on lead times for the supplier. To override the estimate— 

11.Click on the top field, and type the ship date. 

Cost (actual/estimated) 
The top field shows the shipment’s actual cost. The Estimated field is calculated based on 
the product’s current effective product cost on the ship date. To override the estimate— 

12.Click on the top field, and type the shipment’s exact cost. 

Freight (actual/estimated) 
The top field shows the actual freight cost. This amount includes any additional 
charges (i.e., clearance fees) incurred while getting the product delivered. The 
estimated field shows a calculation based on a percentage of the product cost. To 
change the estimate— 

13.Click on the top field, and type the shipment’s actual freight cost. 
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The Note Tab has a memo field for additional information about the shipment. 

14.Click on the Note Tab, and type any relevant notes about the shipment. 

The Display Note field tells PipeLine to include the note in the PipeLine reports. 

15.Click on the Display Note field to include the note in PipeLine reports. 

16.Click on the Save button to save the data. 

Editing Shipment Data 
Shipment data for a particular product can be edited. 

With the Shipments screen displayed— 

1. Select the Category for the product you want to edit. 

If you do not remember the category for the product you need 
to edit, select All Categories from the Category pull-down 
menu to access all the products in your program. 

2. Click on the arrow next to the Product field, and from the pull-down menu, select 
the product you need to edit. 

3. Click on the shipment record you need to edit. 

4. Click in the field you need to edit, and type the new data. 

5. Click on the Save button to save the data. 
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Copying Shipment Data 
The Copy button enables you to copy shipment data. Copied data can be edited to reflect a 
particular shipment, which reduces the amount of data entry required. 

With the Shipments screen displayed— 

1. Click on the arrow next to the Category field, and select the category for the 
product you need to copy shipment data from. 

2. Click on the arrow next to the Product field, and select the product you need to 
copy shipment data from. 

3. Select the shipment data you need to copy. 

4. Click on the Copy button. 

!! You must enter a new receipt date in the Receive Date field. 

PipeLine assigns an ID number to the copied data. 

5. Edit the shipment record, as needed. 

6. Click on the Save button to save the changes. 

Plan Shipments By Date 
PipeLine enables you to add shipments based on the amount of stock needed to reach a 
desired stock level on a date you specify for selected products. Use the Plan By Date button 
to plan shipments. 

With the Shipments screen displayed— 

1. Click on the Plan By Date button. 

The Plan By Date window is displayed (see Figure 5-5). 
This window includes every product in the currently 
selected category for the current program. 

2. Click on the product(s) you want to plan 
based on the product’s receipt date. 

3.	 Click in the Receive Date field, and type the 
date you want the shipment(s) delivered. 

4. Click on the OK button. 

Figure 5-5—Plan By Date window 
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If the receipt date you enter is not the last day of the current month, a message is displayed. 

5. Click on the Yes button. 

Deleting Shipment Data 
Use the Delete button to delete the shipment data of a particular product. 


With the Shipments screen displayed— 


1. Click on the arrow next to the Category field, and select the category from the 
pull-down menu. 

2. Click on the arrow next to the Product field, and select the product from the pull-
down menu. 

3. Select the shipment record you need to delete. 

4. Click on the Delete button, and a confirmation message is displayed. 

5. Click on Yes to delete the selected shipment data. 

Stock 
Use the Stock Tree View option to track products already in stock, or to track products during a 
physical inventory of your entire program when the stock balances are known or estimated. 

1. Click on the Stock Tree View option. 

PipeLine displays the Stock screen (see Figure 5-6). 
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Figure 5-6—Stock screen       

Adding Stock Data 
Use the Add button to record positive or negative quantities that would change a program’s 
stock balance. These changes are not due to consumption or shipments. They are, most often, 
due to losses or transfers. 

With the Stock screen displayed— 

1. Click on the arrow next to the Category field, and select the category from the 
pull-down menu. 

2. Click on the arrow next to the Product field, and select the product from the pull-
down menu. 

3. Click on the Add button. 

PipeLine blanks out the lower half of the Stock screen (see Figure 5-7). 

Figure 5-7—Stock screen data entry area      

The Date field displays the date the adjustment occurred, or when it is expected to occur. 

4. Type the date of the adjustment. 
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The Adjustment (Packs) field shows the adjustment amount (in units). 
•	 A loss is recorded as a negative number (i.e., -1, -33, -100, etc.). This adjustment is 

subtracted from the month’s ending balance. 

•	 A transfer into your program from another program is recorded as a positive number 
(for example, 1, 33, 100, etc.). This adjustment is added to the month’s ending 
balance. 

5. Click in the Adjustment (Packs) field, and type the adjustment amount. 

Entering Stock Count Data 
Use the Enter Count button to calculate an adjustment based on the inventory count data. 

� You must enter a date before you can use the Enter Stock Count feature. 

6. Click on the Enter Count button. 

The Stock Count window is displayed (see 
Figure 5-8). 

The Count field displays the amount of the 
product in stock (in units) as of the date you 
specified. This value includes storage 
facilities and service delivery points. 

7. Type the stock count. 

Figure 5-8—Stock Count window 

The Recalculate button allows PipeLine to 
calculate the adjustment by subtracting the 
current balance from the entry in the count 
field. Figure 5-9 displays the Stock Count 
window, and shows an adjustment based on 
supplied data. 

Figure 5-9—Stock Count window with adjustment 
8. Click on the Save button to save 


the data. 


PipeLine populates the Adjustment and Stock Count fields based on the data you enter. 

The Data Source field displays the source of the adjustment. 

9. Click on the arrow next to the Data Source field, and select the data source from 
the pull-down menu. 
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The Note field is a memo field where you can enter additional information about the 
adjustment. 

!! Always explain the adjustment. 

• If a loss, note the reason for the loss. 

• If a transfer, note the source or destination of the transfer. 

10.Click on the Display Note field to include the note in the PipeLine reports. 

11.Click on the Save button to save the data. 

Editing Stock Data 
Stock data for a particular product can be edited. 

With the Stock screen displayed— 

1. Select the Category for the product you want to edit. 

If you do not remember the category for the product you need 
to edit, select All Categories from the Category pull-down 
menu to access all the products in your program. 

2. Click on the arrow next to the Product field, and select the product you need to 
edit from the pull-down menu. 

3. Select the stock record you need to edit. 

4. Click in the field you want to edit, and type the new data. 

5. Click on the Save button to save the data. 

Deleting Stock Data 
Use the Delete button to delete selected stock data from a selected product. 

With the Stock screen displayed— 

1. Click on the arrow next to the Category field, and select the category from the 
pull-down menu. 

2. Click on the arrow next to the Product field, and select the product from the pull-
down menu. 
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3. Select the record you want to delete and click on the Delete button. 

A confirmation message is displayed. 

4. Click on Yes to delete the selected data. 
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Introduction 
This section lists the PipeLine graphs and provides a brief description of each. Also included is 
guidance on how to use the output from the graphs for pipeline monitoring and procurement planning. 

PipeLine Graphs 

PipeLine can create the following graphs. 

Stock Status 
Monthly or quarterly bar chart showing the actual and projected months of stock for a 
product or type, compared to the program’s maximum and minimum levels. 

Consumption 
Monthly or quarterly bar chart showing actual and forecast consumption by product or type. 

Trend Analysis 
Monthly or quarterly bar chart showing a trend analysis of a selected set of 
consumption data for a particular product. 

Couple-Years of Protection (CYP) 
Monthly or quarterly bar chart showing actual and forecasted couple-years of 
protection (CYP) by product or method. 

� The couple-years of protection (CYP) graph can only be created for 
products that belong to a Method with a CYP factor. 

Stock Status Graph 
The Stock Status graph provides a quick view of your program’s actual and forecasted stock 
levels. It creates a bar chart, by month or quarter, showing months of stock for a selected product 
or type that is expected to be available in your logistics system at the end of the month or quarter. 
If you enter the maximum and minimum desired stock levels for a product, these are displayed 
and compared to estimated stock balances. 
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When you talk with policymakers, donors, and other suppliers, use this graph to show an overview of 
your stock situation. If the graph shows forecast stock levels that are far below your minimum, or 
if it projects that you will stock out of the product or type, you should begin plans to obtain 
additional supplies. You may also need to review your consumption forecast for accuracy. 

If the graph shows actual stock levels that are far below minimum or above maximum, review past 
procurement plans and your inventory control procedures to determine why stock levels are out of 
balance. Better inventory control procedures, or more accurate stock data, may prevent future problems. 

Creating a Stock Status Graph 
The Stock Status graph is based on the last product or method that was updated or displayed. The 
default time period is five years, which includes the current year, previous two years, and 
following two years. Using stock data, you can create a stock status graph for any product in 
your program. 

� The procedure for creating a Stock Status graph is the same regardless of 
the product you choose. 

The following explains how to create a Stock Status graph. 

From the Tree View— 

1. Click on the Stock Status Tree View option (under Graphs) to display the Stock 
Status screen (see Figure 6-1). 

Figure 6-1—Stock Status screen        
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2. Click on the arrow next to the Category field, and select a category from the pull-
down menu. 

Or, select All Categories from the Category pull-down menu to access all the 
products in your program. 

The Display field enables you to create a graph that displays stock data on a monthly or 
quarterly basis. 

3. Click on the arrow next to the Display field, and select Monthly to display the data 
by month or Quarterly to display the data by quarter. 

Products and Types 
Using PipeLine, you have the option of selecting 
items by Product or Type (see Figure 6-2). 

The Product option is selected by default. To display 
data by Type, which is a list of Types filtered by 
Category,— 

Figure 6-2—Display options    
4. Click on the Type option. 

PipeLine changes the label of the Product box to

Type, and it displays all Types associated with the 

selected category (see Figure 6-3). 


The Product/Type box shows the product(s) you 

can select to create a stock status graph. 


5. Click on the Product or Type you need to 

create the graph. 


The From and Through fields let you determine  
the span of time the graph will cover. 

6. Click on the arrow next to the From field, and select the starting year for the 
report period. 

7. Click on the arrow next to the Through field, and select the last year of the report 
period. 

Excluding Planned Shipments 

The Exclude Selected field enables you to exclude planned shipments from the Stock 
Status graph by letting you exclude the suppliers of these shipments from the output. 

Figure 6-3—Display options    
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Figure 6-4—Select Suppliers to Exclude box 

8. Click on the Exclude Selected field. 

The Select Suppliers to Exclude box opens, 

displaying the suppliers of your products (see 

Figure 6-4). 


9.	 Click on the suppliers whose planned 

shipments you want to exclude from the 

graph. 


To select more than one supplier— 

10.Hold down the Control key <Ctrl>, and 

click on each supplier you want excluded from the graph. 


See page 6-11 for information on previewing, printing, and creating a PDF of the Stock 
Status graph. 

Consumption Graph 
The Consumption graph shows actual and forecast consumption (quantity dispensed to clients) of 
a selected product/type. This graph can display monthly or quarterly consumption. 

Use this graph when you discuss the reasonableness and reliability of your consumption 
forecasts. If the pattern or quantity of the forecast consumption is different from the actual 
consumption, ask why. If future growth is projected to be more rapid than past growth, have 
good justification based on program plans and evidence that other necessary resources (staff, 
facilities, money) will be available. 

Creating a Consumption Graph 
The graph is based on the last product or method and the period updated or displayed. The 
default period is five years (the previous two years, current year, and following two years). A 
graph can be created for a specific product or type. 

From the Tree View— 

1. Click on the Consumption Tree View option. 

The Consumption Graph screen is displayed (see Figure 6-5). 

2. Click on the arrow next to the Category field, and select a category from the pull-
down menu. 

Or, select All Categories from the Category pull-down menu to access all the 
products in your program. 
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Figure 6-5—Consumption screen    

The Display field lets you create a graph that displays stock data on a monthly or quarterly basis. 

3. Click on the arrow next to the Display field, and select Monthly to display the data 
by month or Quarterly to display the data by quarter. 

Products and Types 
Using PipeLine, you can select items by Product or Type 

(see Figure 6-6). 


The Product option is selected by default. To display data 

by Type, which is a list of Types filtered by Category,— Figure 6-6—Display options    


4. Click on the Type option. 

PipeLine changes the label of the Product box to Type 
and displays all Types associated with the selected 
category (see Figure 6-7). 

The Product/Type box shows the products that you can 
select to create a stock status graph. 

Figure 6-7— Display options  
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5. Click on the Product or Type you need to create the graph. 

The From and Through fields enable you to determine the span of time the graph will cover. 

6. Click on the arrow next to the From field, and select the starting year of the 
report period. 

7. Click on the arrow next to the Through field, and select the last year of the 
report period. 

The Unit of Measure area (see figure 6-8) lets you select whether Packs or Basic Units are 
displayed. 

8. Click on the Packs field to create a report  

based on packs. 


Click on the Basic Unit (BU) field to create a Figure 6-8—Unit of Measure Values    

report based on the basic units. 

See page 6-11 for information on previewing, printing, and creating a PDF of the 

Consumption graph. 


Trend Analysis Graph 
The Trend Analysis Tree View option plots a straight line trend through actual consumption data 
and calculates the quantity on the trend line that corresponds to each month, quarter, and year up 
to ten years from the first trend year. The trend is based on the Semi-Average or Linear 
Regression calculation method. 

Semi-Average 
Divides the actual consumption data into the first and second half, and calculates the 
average of each. If the series is an odd number, the middle number is included in both 
averages. The trend is calculated to intercept these averages. 

Linear Regression 
Is a statistical formula applied to the actual consumption data series to minimize the 
distance of the data series points from the trend. 

The trend is calculated based on actual consumption by month, as reported in the Stock Status 
report. However, a report showing the data by quarter may be more useful. Use the Monthly 
display if you entered monthly consumption data, and if you want to see the seasonality or 
variation of the data compared to the straight trend. 

The first year of the report must have actual consumption records because the trend is calculated 
based on actual consumption records in the first year and subsequent actual consumption records 
up to ten years (if they exist). The trend is calculated and displayed for a period up to ten 
calendar years from the first year. 
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Use this report to compare your forecast to the trend of actual data, or use it as a starting point 
for or analysis of, a new forecast. 

Creating a Trend Analysis Graph 
This graph shows consumption data in PipeLine and the trend of the actual consumption 
data. Forecast consumption data are displayed in a bar graph that is not in the trend 
calculation. 

From the Tree View— 

1. Click on the Trend Analysis Tree View option. 

The Trend Analysis screen is displayed (see Figure 6-9). 

Figure 6-9—Trend Analysis screen      

2. Click on the arrow next to the Category field, and select a category from the pull-
down menu. 

Or, select All Categories from the Category pull-down menu to access all the 
products in your program. 

3. 	 Click on the arrow next to the Product field, and select a product from the pull-
down menu. 

4. Click on the arrow next to the Display field, and select Monthly to display the data 
by month or Quarterly to display the data by quarter. 
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5. Click on the arrow next to the From field, and select the starting year of the report 
period from the pull-down menu. 

6. Click on the arrow next to the Through field, and  
select the last year of the report period from the  
pull-down menu. 

The Calculation area of the Consumption Trend Analysis 
screen (see Figure 6-10) lets you create a trend graph 
based on semi-averages or linear regression. Figure 6-10—Calculation types    

7. Click on the Semi-Averages field (under 
Calculation) to create a report based on semi-averages. 

Click on the Linear Regression field (under Calculation) to create a report based 
on linear regression. 

The Unit of Measure area (see figure 6-11) lets you select whether Packs or Basic Units are 
displayed. 

8. Click on the Packs field to create a report 

based on packs. 


Click on the Basic Unit (BU) field to create a 

report based on the basic units. 


See page 6-11 for information on previewing, printing, and creating a PDF of the Trend 
Analysis graph. 

Couple-Years of Protection (CYP) Graph 
The couple-years of protection (CYP) graph uses the conversion factors in the Categories table 
of the Background Data menu to convert consumption data for selected product(s) or method(s) 
to CYP units. 

Figure 6-11—Unit of Measure values    

� The couple-years of protection (CYP) graph can only be created for 
products that belong to a Method with a CYP factor. 

The graph lets you measure and compare the extent of coverage provided across methods. For 
example, you will need approximately 120 condoms to protect one couple for one year but you 
will need only four units of Depo-Provera. The coverage you achieve from 120 condoms 
consumed is comparable to four Depo-Provera injections. 

You can compare coverage achievement over time despite changes in the method mix. You may 
dispense fewer units of contraceptives in the future, but if these units have higher CYP factors, 
you could provide greater coverage. 
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Use this graph to evaluate and monitor program coverage and achievement. (See the FPPMES 
User’s Manual for more information.) 

Creating the CYP Graph 
This graph is based on the percentage of one year during which each counted unit of a 
product/method provides protection from pregnancy. 

For example: Four Depo-Provera injections are needed to provide one year of 
protection. Therefore, a single injection provides protection for .25 of a year (three 
months). 

The number of CYPs is calculated by multiplying products/methods dispensed by the 
appropriate conversion factor. If 100 Depo-Provera injections were dispensed during a 
quarter, then 25 CYPs were generated (100 ×.25). To create a CYP graph— 

From the Tree View— 

1. Click on the Couple-Years of Protection (CYP) Tree View option. 

The Couple-Years of Protection (CYP) screen is displayed (see Figure 6-12). 

Figure 6-12—Couple-Years of Protection (CYP) screen     
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The Product option is selected by default. To display data by Method— 

2. Click on the Method option. 

PipeLine changes the label of the Product box to Method 
and displays all Methods associated with the selected 
category (see 6-13). 

The Product/Method box shows which product you can 
select to create a stock status graph. 

3. Select the Product(s)/Method(s) you want 	 Figure 6-13— Display options 

included on the graph. 

4. Click on the arrow next to the Display field, and select Monthly to display the data 
by month or Quarterly to display the data by quarter. 

5. 	 Click on the arrow next to the From field, and select the starting year of the report 
period. 

6. 	 Click on the arrow next to the Through field, and select the last year of the report 
period. 

The Unit of Measure area (see figure 6-14) lets you select whether Packs or Basic Units are 
displayed. 

7. Click on the Packs field to create a report based on 
packs. 

Click on the Basic Unit (BU) field to create a report 

based on the basic units. 


Figure 6-14—Unit of Measure 

See page 6-11 for information on previewing, printing, and Values 

creating a PDF of the CYP graph. 

Exporting the CYP Graph 
Use the Export button to export the data of a CYP graph. 


With the Couple-Years of Protection (CYP) screen displayed— 


1. Create a CYP graph for a selected product/method. 

See Creating the CYP Graph beginning on page 6-9. 

2. Click on the Export button. 
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Figure 6-15—Export CYP Data window 

PipeLine displays the Export CYP Data window 
(see Figure 6-15). Use the options in this window 
to arrange the data in a Microsoft Office Excel 
spreadsheet. 

CYP Graph 
Incorporates the CYP factors into the 

consumption totals for use in ad hoc reports 

and graphs. 


FPPMES 
Arranges the data for use with the Family Planning Program Monitoring and  
Evaluation System. 

The default is CYP Graph. 

3. Click on the OK button to accept the default. 

Or, Click on FPPMES, and click on the OK button. 

PipeLine displays the Output window with the default file name (based on your selection) 
displayed in the File Name field. 

4. Click on the OK button to accept the default. 

Or, click on the File Name field, and type the export file’s name. 

5. Click on the OK button to save the data in the selected format. 

Previewing, Printing, and Creating a PDF of PipeLine Graphs 
The procedure for previewing and printing PipeLine graphs is the same regardless of the type 
of graph you create. 

Previewing a Graph 
A compact version of the graph (regardless of the type you create) is continually 

displayed on the lower half of your screen. To preview the entire graph— 


1. Click on the Preview button. 

The selected graph is displayed onscreen for you to review. If you are satisfied with the 
data as presented, you can print the graph from the preview screen. 
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2. Click on the print icon  to send the graph to your default printer. 

3. Click on the close icon  to return to the previous screen. 

Printing a Graph 
To send a graph directly to your default printer, without previewing it— 

1. Click on the Print button. 

Creating a PDF of a Graph 
To create a PDF of a graph without previewing it— 

1. Click on the PDF button. 

To create a PDF of a graph from the preview of the graph— 

2. Click on the Preview button. 

3. Click on the PDF icon to create a PDF of the graph. 

!! To create a PDF, you must first choose a PDF writer. For more 
information on choosing a PDF writer, see page A-16. 
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Introduction 
This section describes the PipeLine reports and provides guidance on how to interpret and use 
these reports for pipeline monitoring and procurement planning. 

The following PipeLine reports are available: 

Stock Status 
Spreadsheet by month or quarter showing detailed figures on which the Stock Status 
graph is based. 

Shipment Summary 
Report showing shipment costs, including product and freight costs, for selected 
supplier/status or product/status. 

Shipment Orders 
Report showing quantities and cost of orders for a selected supplier/status. 

Annual Shipment Costs 
Report showing the actual or estimated cost of shipments received or expected during a 
calendar year. 

Pipeline Action 
Report showing the next procurement action needed for products in your system. 

Pipeline Problem 
Report highlighting actual, or expected serious pipeline problems (e.g., stockouts, 
shortfalls, or surpluses), for products in your program. 

Procurement Table 
Report that generates data in the format used in USAID‘s contraceptive procurement 
tables (CPT). 
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Stock Status Report 
This report is PipeLine’s primary output. It includes the data maintained by PipeLine for a single 
product or type and for a selected period of calendar years. This report (on which a Stock Status 
graph is based) displays detailed figures for a selected product or type. Based on the product’s 
commodities records, the report calculates the months of stock represented by the ending balance 
for each period, with shortfalls or surpluses, based on the product minimum and maximum levels.  

Each row represents one period and displays the beginning balance, details (quantity, status and 
supplier) regarding shipments received or due, actual or forecast consumption, stock 
adjustments, stock in months, desired stock, shortfall/surplus, and ending balance. The desired 
stock shows the quantity needed in the period for the ending balance to meet the product’s 
maximum desired quantity, and the Shortfall/Surplus is equal to the difference between the 
ending balance and minimum desired quantity, or the maximum desired quantity. Shortfalls are 
expressed in negative numbers. Surpluses are expressed in positive numbers. Shipments are 
displayed on the row of the period they have been (or are expected to be) received, regardless of 
the shipment’s status or lead time. 

Use this report for detailed procurement planning for each product. The Stock Status report 
displays the supplier and shipment status for each shipment. If shortfalls are projected, plan 
additional shipments, or advance the receipt date of expected shipments. If a surplus is projected, 
postpone a shipment, or reduce the quantity you expect to receive. If there are excessive 
unexplained adjustments, investigate the quality of your data. 

Creating the Stock Status Report 

The Stock Status report is based on the last product or method updated or displayed. The 
default time period is five years, which includes the current year, previous two years, and 
following two years. Using stock data, you can create a stock status report for any product in 
your program. 

� The procedure for creating a Stock Status report is the same for every 
product you choose. 

The following explains how to create a Stock Status report. 

From the Tree View— 

1. Click on the Stock Status Tree View option (under Reports) to display the Stock 
Status screen (see Figure 7-1). 
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Figure 7-1—Stock Status screen        

2. Click on the arrow next to the Category field, and select a category from the pull-
down menu. 

Or, select All Categories from the Category pull-down menu to access all 

products in your program. 


The Display field enables you to create a report displaying stock data on a monthly or 
quarterly basis. 

3. Click on the arrow next to the Display field, and select Monthly to display the data 
by month or Quarterly to display the data by quarter. 

Products and Types 
PipeLine gives you the option of selecting items by 
Product or Type (see Figure 7-2). 

The Product option is selected by default. To display data 
by Type, which is a list of Types filtered by Category,— 

4. Click on the Type option. Figure 7-2—Display options       
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PipeLine changes the label of the Product box to 

Type and displays all Types associated with the 

selected category (see Figure 7-3). 


The Product/Type box shows which product(s) you 
can select to create a stock status report. 

5. Click on the Product or Type you need to 

create the report. 


The From and Through fields let you determine the span of time the report will cover. 

6. Click on the arrow next to the From field, and select the starting year of the 
report period. 

7. Click on the arrow next to the Through field, and select the last year of the 
report period. 

Excluding Planned Shipments 
The Exclude Selected field enables you to exclude planned shipments from the Stock 
Status report by excluding the suppliers of these shipments from the output. 

8. Click on the Exclude Selected field. 

The Select Suppliers To Exclude box opens, showing the 
suppliers of your products (see Figure 7-4). 

9. Click on the suppliers whose planned shipments 

you want excluded from the report. 


To select more than one supplier— 

10.Hold down the Control key <Ctrl>, and click on 

each supplier you want excluded from the report. 


See page 7-15 for information on using the Show Data and Hide Data buttons. 


See page 7-16 for information on previewing, printing, or creating a PDF of the Stock Status report. 


Figure 7-3—Display options       

Figure 7-4—Select Suppliers to 
Exclude box    
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Shipment Summary Report 
The Shipment Summary report calculates the cost of products and freight for selected shipments. 
Data in this report can be displayed by supplier or product. 

Shipment Summary by Supplier 
This report groups shipments and subtotals costs by supplier. This is useful if you have 
products with multiple suppliers but you need to look at costs associated with individual 
suppliers. Use this report when you review shipment information with suppliers and 
estimating costs and budgeting. 

Shipment Summary by Product 
This report groups shipments by product, regardless of supplier. This is useful if you have 
products with multiple suppliers but you need to see costs associated with individual 
products. Use this report to review shipments input to PipeLine and to check their 
expected receipt dates, quantities, status, etc. 

Creating a Shipment Summary Report 
You can use PipeLine to create a Shipment Summary report (grouped by supplier or 
product). 

From the Tree View— 

1. Click on the Shipment Summary Tree View option to display the Shipment 

Summary report screen (see Figure 7-5). 


Figure 7-5—Shipment Summary screen       
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2. Click on the arrow next to the Category field, and select a category from the pull-
down menu. 

Or, select All Categories from the Category pull-down menu to access all the 
products in your program. 

By default, the Shipment Summary report is set for all suppliers, 
with all shipment status types pre-selected. 

Figure 7-6—Display options       
To create a report grouped by products— 

3. Click on the Product field in the Display By area of the Shipment Summary report 
screen (see Figure 7-6) to create a report grouped by products. 

Regardless of the type of report you choose to create, you can fine-tune the report. 

4. For reports by supplier, click on the Page Break Between Suppliers field to 
include a page break after each supplier included in the report. 

Or, for reports by products, click on the Page Break Between Types field to 
include a page break after each Type included in the report. 

Limiting the Report’s Scope 
You can limit the scope of the report. 


To limit the number of suppliers or products included in the report— 


5. For Suppliers, click on the supplier you want included in the report. 

Or, for Products, click on the product you want included in the report. 

To select multiple suppliers or products— 

6.	 Hold down the <Ctrl> key, and click on each supplier you want included in the 
report. 

Or, hold down the <Ctrl> key, and click on each product you want included 
in the report. 

To limit the shipment statuses included in the report— 

7. In the Status field, click on the status you want included in the report. 

To select multiple statuses— 

8. 	 Hold down the <Ctrl> key, and click on each status you want included in the 
report. 
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The From and Through fields define the reporting period. By default, the reporting 
period begins on the year of your first shipment and ends on the year your last shipment 
was received, or is expected to be received. 

To change the reporting period— 

9. Click on the From field, and select the start year from the pull-down menu. 

10.Click on the Through field, and select the end year from the pull-down menu. 

See page 7-15 for information on using the Show Data and Hide Data buttons. 

See page 7-16 for information on previewing, printing, or creating a PDF of the Shipment 
Summary report. 

Shipment Orders Report 
This report can be used as a draft order for new shipments, and it can be used to confirm 
information on previous shipments. 

Creating a Shipment Orders Report 
You can use PipeLine to create the Shipment Orders report. 

From the Tree View— 

1. Click on the Shipment Orders Tree View option. 

The Shipment Orders report screen is displayed (see Figure 7-7). 

Figure 7-7—Shipment Orders screen        

By default, the Shipment Orders report is set for all suppliers, with all shipment statuses selected. 
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To create a report for a specific supplier— 

2. Click on the arrow next to the Category field, and select a category from the pull-
down menu. 

Or, select All Categories from the Category pull-down menu to access all the 
products in your program. 

3. In the Supplier field, click on the supplier you want included in the report. 

To select multiple suppliers— 

4. Hold down the <Ctrl> key, and click on each supplier you want included in the 
report. 

To limit which shipment statuses are included in the report— 

5. In the Status, click on the status you want included in the report. 

To select multiple statuses— 

6. Hold down the <Ctrl> key, and click on each status you need included in the 
report. 

The From and Through fields define the reporting period. By default, the reporting period 
begins on the year of your first shipment and ends on the year your last shipment was 
received, or is expected to be received. 

To change the reporting period— 

7. Click on the From field, and select the start year from the pull-down menu. 

8. Click on the Through field, and select the end year from the pull-down menu. 

The Page Break between Status field enables you to include page breaks in the report. 

9. Click on the Page Break Between Status field to include a page break after each 
shipment status included in the report. 

See page 7-15 for information on using the Show Data and Hide Data buttons. 

See page 7-16 for information on previewing, printing, or creating a PDF of the Shipment 
Order report. 

Annual Shipment Costs Report 
The Annual Shipment Cost report calculates annual shipment costs, by supplier. It calculates 
the total cost (product value and freight) of shipments received, or expected to be received, in a 
calendar year. It shows yearly totals, not the cost of individual shipments. Costs associated with 
the procurement and delivery of a shipment (e.g., taxes, customs clearance fees) should be included 
in the freight cost. Use this report when you talk to suppliers to help assess the annual costs of 
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supplying your program. If you procure your own commodities, this report may be helpful for 
budgeting. 

Creating an Annual Shipment Costs Report 
By default, the Annual Shipment Costs report is set for all suppliers, products, and shipment 
statuses. 

From the Tree View— 

1. Click on the Annual Shipment Costs Tree View option. 

The Annual Shipment Costs screen is displayed (see Figure 7-8). 

Figure 7-8—Annual Shipment Costs screen        

Limiting the Report’s Scope 
You can limit the scope of the report. 

2. Click on the arrow next to the Category field, and select a category from the 
pull-down menu. 

Or, select All Categories from the Category pull-down menu to access all the 
products in your program. 

3. Click on the arrow next to the Supplier field, and select a supplier from the 
pull-down menu. 

4. Click on the arrow next to the Product field, and select a product from the pull-
down menu. 
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5. Click on the Exclude Inactive Products field to have the report list only those 
products that are currently active. 

6. Click on the Status field, and select the shipment status you need. 

� You may choose one or all items from the category, supplier, product, 
and status menus. 

The From and Through fields show the reporting period. The default reporting period for 
an Annual Shipment Cost report is five years. 

To change the reporting period— 

7. Click on the arrow next to the From field, and from the pull-down menu, select 
the starting year of the report period. 

8. Click on the arrow next to the Through field, and from the pull-down menu, 
select the last year of the report period. 

See page 7-16 for information on previewing, printing, or creating a PDF of the Annual 
Shipment Costs report. 

Pipeline Action Report 
The Pipeline Action report creates a comprehensive analysis of product pipelines and 
information on needed actions. It shows the procurement actions needed next for the products 
you monitor, organized by the date of the action needed next. Possible actions include— 

Plan Shipment 
A shipment needs to arrive in the month specified to prevent stock levels from dropping 
below minimum and to bring them back to the maximum level. Based on lead times, 
this planning should be done no later than the action date. Before taking action, review 
the Stock Status report to determine the impact this will have on future stock status. 

Confirm Shipment Ordered 
A shipment planned to arrive on the receive date should be ordered no later than the 
action date. Ensure that the shipment was ordered. Update the status and date ordered on 
the Shipments form. 

Confirm Shipment Dispatched 
A shipment ordered to arrive on the receive date should be shipped no later than the 
action date. Ensure that the shipment was dispatched. Update the status and date 
shipped on the Shipments form. 
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Confirm Shipment Received 
A shipment shipped to arrive on the receive date should be confirmed upon arrival. 
Ensure that the shipment was received. Update the status and date received on the 
Shipments form. 

Surplus, Change 
An arriving shipment will push stock levels above the maximum desired level. 
Determine if you should cancel or postpone the shipment, or transfer stock to another 
program. Update the PipeLine data accordingly. 

Use this report to guide your pipeline monitoring activities. With good data, you can take each 
required action on or before the date the action is required to prevent stock imbalances before 
they occur. You should, however, review the Stock Status report and graph before taking 
procurement actions. 

Creating a Pipeline Action Report 
This report is generated based on all shipments and needed quantities for active products, and 
it is displayed on the screen. Received shipments are not included. 

From the Tree View— 

1. Click on the Pipeline Action Tree View option. 

The Pipeline Action screen is displayed (see Figure 7-9). 

Figure 7-9—Pipeline Action screen        

Limiting the Report’s Scope 
You can limit the scope of the report. 
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2. Click on the arrow next to the Category field, and select a category from the 
pull-down menu. 

Or, select All Categories from the Category pull-down menu to include all the 
products in your program. 

The From and Through fields show the reporting period. 

To change the reporting period— 

3. Click on the arrow next to the From field, and, from the pull-down menu, 
select the starting year of the report period. 

4. Click on the arrow next to the Through field, and, from the pull-down menu, 
select the last year of the report period. 

See page 7-15 for information on using the Show Data and Hide Data buttons. 

See page 7-16 for information on previewing, printing, or creating a PDF of the Pipeline 
Action report. 

Pipeline Problem Report 
The Pipeline Problem report summarizes pipeline problems that were observed in an analysis of 
active products. A problem is defined when the actual or expected ending stock balance falls 
below minimum, reaches zero, or rises above maximum on the problem date. This report 
highlights actual or expected serious pipeline problems for the products you track. It does not 
consider lead times, only the dates that problems will occur if actions are not taken. This report 
alerts you to the following problems: 

Below Minimum 
A product will fall below the desired minimum stock level before the date of the problem. 
The problem corresponds to an action to plan shipment in the Pipeline Action report. 

Stock Out 
A product’s stock level will reach zero before the date of the problem if no procurement 
actions are taken, and the primary data entered for the product are accurate. 

Above Maximum 
A shipment arriving on the date of the problem will cause a product to be above the 
desired maximum stock level at the end of the month. The problem corresponds to the 
Surplus, Change action in the Pipeline Action report. 

Use this report to identify problems that require urgent action. If the report shows many 
problems, you may need to review your maximum/minimum stock policies, lead time estimates, 
suppliers’ performance, and amount of resources devoted to commodities. This report can help 
you negotiate with donors and suppliers to mitigate anticipated pipeline problems. 
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Creating the Pipeline Problem Report 
The report is based on actual and expected stock levels for active products. 

From the Tree View— 

1. Click on the Pipeline Problem Tree View option. 

The Pipeline Problem report screen is displayed (see Figure 7-10). 

Figure 7-10—Pipeline Problem report screen     

Limiting the Report’s Scope 
You can limit the scope of the report. 

2. Click on the arrow next to the Category field, and select a category from the 
pull-down menu. 

Or, select All Categories from the Category pull-down menu to include all the 
products in your program. 

See page 7-15 for information on using the Show Data and Hide Data buttons. 

See page 7-16 for information on previewing, printing, or creating a PDF of the Pipeline 
Problem report. 

Procurement Table Report 
This report displays data in the USAID CPT calendar year format. It applies the same formulas 
to calculate desired end of year stock, net supply, and supply shortfall for the CPT year and the 
following year. See the CPT Guidance Manual (available from USAID) for information on how 
these calculations are made. Request the product from USAID with the support of this report. If 
USAID agrees to supply the product, plan your shipments so that the supply shortfall is near zero. 
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Use this report when you talk to contacts familiar with the CPT format. It can be used to 
complete manual CPTs requested in USAID’s CPT Guidance as supporting documentation for 
USAID orders. 

Creating a Procurement Table Report 
The default period is five years, which includes the selected year, previous two years 
(historical), and following two years (forecast). 

From the Tree View— 

1. Click on the Procurement Table Tree View option. 

The Procurement Table report screen is displayed (see Figure 7-11). 

Figure 7-11—Procurement Table screen       

Limiting the Report’s Scope 
You can limit the scope of the report. 


To select a specific category— 


2. Click on the arrow next to the Category field, and select a category from the 
pull-down menu. 

Or, select All Categories from the Category pull-down menu to include all the 
products in your program. 

Products associated with the selected category are displayed in the Product box. 

7-14 



7 PIPELINE REPORTS 

3. Click on the product you want included in the report. 

Or, hold down the <Ctrl> key, and click on each product you want included in 
the report. 

The Prepared By field shows the username of the person preparing the report. By default, 
PipeLine displays the username of the person currently logged into the system. To change 
the username— 

4. Highlight the entry in the Prepared By field, and type the name of the person 
preparing the report. 

The Date Prepared field shows the date the report was prepared. By default, PipeLine 
displays the current system date. To change the entry— 

5. Highlight the entry in the Date Prepared field, and type the date the report 
was prepared. 

� Always use a four-digit year (for example, 2002, 2003, 2004, etc.). 

The End of Year field (see Figure 7-12) enables you 

to determine how much stock you want to have on 

hand at the end of the year. 


6. Click on the arrow next to the End of Year 

field, and select the desired months of stock Figure 7-12—End of Year field


from the pull-down menu. 


The For Year field displays the reporting year. 

7. Click on the arrow next to the For Year field, and select the desired CPT year 
from the pull-down menu. 

See page 7-15 for information on using the Show Data and Hide Data buttons. 

See page 7-16 for information on previewing, printing, or creating a PDF of the Procurement 
Table report. 

Showing and Hiding Report Data 
With the exception of the Annual Shipment Costs report, PipeLine report screens have a 
Show Data button that enables you to quickly view a sampling of the data to be included in a 
given report. This feature only works when one data set (product, type, supplier, etc.) is 
selected for a given category. 
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Showing Report Data 
To use the Show Data feature— 

1. Select the criteria for a report based on the report’s instructions. 

2. Click on the Show Data button. 

Data associated with the selected report are displayed on a screen similar to Figure 7-13. 
This example represents data generated by the Shipment Summary report. 

Figure 7-13—Example of Show Data display 

Use the Scroll bar (if needed) to view all the generated data. 

Hiding Report Data 
The Hide Data button becomes active when report data is displayed on a given report form. 

To hide the report data— 

1. Click on the Hide Data button. 

Previewing and Printing PipeLine Reports 
The procedure for previewing and printing PipeLine reports is the same for all types of reports. 

Previewing a Report 
To preview a report— 

1. Click on the Preview button. 
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The report is displayed onscreen. If you are satisfied with the data as presented, you can 
print the report from the preview screen. 

2. Click on the print icon  to send the report to your default printer. 

3. Click on the close icon  to return to the previous screen. 

Office Links 
The PipeLine Report Viewer Menu has a feature that enables you to export a displayed 
report to one or more of the programs associated with Microsoft Office. This feature is 
called Office Links. 

� You must have Microsoft Office 2000 or above installed on your 
computer to use the Office Links feature. 

To use the Office Links feature— 

1. Select the report criteria, and click on the Preview button. 

2. Click on the Office Links option of the Tool Bar to display the Office Links pull-
down menu. 

3. Select the file format you want to export to from the pull-down menu. 

PipeLine prompts you to name the export file. 

4. Type the export file’s name in the name field, and click on the OK button. 

PipeLine opens the Microsoft Office product associated with the file type where you 
exported the report. 

Printing a Report 
You can send a report directly to your default printer, without previewing it. 

1. Click on the Print button. 

Creating a PDF of a Report 
To create a PDF of a report without previewing it— 

1. Click on the PDF button. 

To create a PDF of a report from the preview of the report — 

2. Click on the Preview button. 
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3. Click on the Office Links option of the Tool Bar to display the Office Links pull-
down menu. 

4. Click on the Send to PDF menu option to create a PDF of the report. 

!! To create a PDF, you must first choose a PDF writer.  For more 
information on choosing a PDF writer, see page A-16. 
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Introduction 
This option (only available in English) is intended for program managers and/or consultants who 
are responsible for managing multiple programs tracked by PipeLine. It aggregates PipeLine data 
from selected programs, and arranges the data so it can be presented in a selected graph or report. 

The following graphs and reports are available: 

Shipments by Supplier Report 
This report is similar to the PipeLine Shipment Summary report. It displays shipment 
costs, including product and freight costs, for selected supplier/status of selected, 
aggregated programs. 

Shipment Orders Report 
This report is similar to the PipeLine Shipment Orders report. It displays quantities and 
cost of orders for a selected supplier/status of selected, aggregated programs. 

Consumption Graph/Export 
This graph is similar to the PipeLine Consumption graph. It produces a monthly or 
quarterly bar chart showing actual and forecast consumption by product or method of 
selected, aggregated programs. This option enables you export aggregated data. 

Couple-Years of Protection (CYP) Graph 
This graph is similar to the PipeLine couple-years of protection (CYP) graph. It produces 
a monthly or quarterly bar chart showing actual and forecast CYP by product or method 
of selected, aggregated programs. 

Access the PipeLine Summary Module 
The PipeLine Summary Module is accessed through PipeLine. 

From the Menu Bar— 

1. Click on the Tools option of the Menu Bar to display the Tools pull-down menu. 

2. Click on the PipeLine Summary pull-down menu option to display the PipeLine 
Summary menu screen. 

8-1 



PIPELINE 4 USER'S GUIDE 

Selecting Programs 
The Select Programs option enables you select the program(s) to aggregate. You must select a 
program or programs for aggregation before you create reports or graphs. 

From the PipeLine Summary Menu— 

1. Click on the Select Programs button. 

PipeLine displays the Select Program screen (see Figure 8-1).  

Figure 8-1—Select Programs screen       

If the program (or programs) you need to aggregate does not appear on the list of available 
programs, you can add them. 

Adding Programs 
Use the Add Program button to add programs for selection and aggregation. 

1. Click on the Add Programs button. 

PipeLine displays the Load Database window. 

2. Locate the data file corresponding to the program you want to add. 

3. Click on the program you need, then click on the Open button. 

PipeLine displays a window similar to Figure 8-2 
to enable you to associate an eight-character ID 
with the selected program.’ 

4. Type the program’s eight-character ID. 

Figure 8-2—Program ID window 
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5. Click on the OK button to save the ID, and close the Program ID window. 

The selected program is displayed in the Available Programs window on the Select Program 
screen. 

6. Repeat the process until you have added all the programs you need. 

After your list is complete, you must select the programs you need to aggregate for reporting. 
This can be done in two ways: 

7. Click on the Select All button to move the programs in the Available 
Programs window to the Selected Programs window. 

Or, click on the program you need, and click on the Select button to

move it from the Available Programs window to the Selected Program 

window. 


8. Repeat, as needed. 

After you select the programs you need— 

9. 	 Click on the OK button to aggregate the data and return to the PipeLine Summary 
menu. 

If you make changes to a program’s data in PipeLine, you must reload the � program into PipeLine Summary to ensure that the changes are reflected 
in the summary reports and graphs. To do this, reselect the program and 
regenerate the aggregated PipeLine Summary to reflect the changes you 
made. 

Creating Reports and Graphs 
PipeLine can create summary reports and graphs. 

Shipment Costs by Supplier Report 
The Shipment Costs by Supplier report groups shipment quantities and costs by supplier, 
method, product, program, and status. 

This is useful if you have shipments going to multiple programs from the same supplier and 
you need to look at total shipments and associated costs for each supplier. 

Use this report to review shipment information (including schedules and budgets) for a 
selected set of programs. 
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From the PipeLine Summary Menu— 

1. Click on the Shipments by Supplier Report button. 

PipeLine displays shipments and their associated costs. Figure 8-3 shows the Shipment Costs 
by Supplier screen, which is displayed after the report is created. Use this screen to create 
shipment cost reports for other suppliers. 

Figure 8-3—PipeLine Summary Shipment Costs by Supplier screen       

By default, the Shipment Costs by Supplier report is set for all products and all shipment 
statuses, with a reporting period of five years. To limit the report’s scope— 

2. Click on the arrow next to the Select Supplier field, and select a supplier from the 
pull-down menu. 

3. Click on the Select Status field and select the shipment status you want. 

4. Click on the From field, and type the beginning date of the report. 

5. Click on the Through field, and type the ending date of the report. 

� Always enter a four-digit year (e.g., 2003, 2004, 2005, etc.). 

The Page Breaks Between Suppliers fields enable you to include page breaks between 
suppliers listed in the report (when the report is generated for more than one supplier). 
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6. 	 Click on the Page Breaks Between Suppliers field to include page breaks between 
suppliers. 

See page 8-11 for information on printing the Shipment Costs by Supplier report. 

Shipment Order Report 
The Shipment Order report groups shipments by status, supplier, method, and product. 
Shipments with status planned are grouped under “New shipments requested this order.” 
Shipments with status shipped or status ordered are grouped under “Confirmation of 
shipments previously ordered and expected.” Shipments with status received are grouped 
under “Shipments received (in report range).” 

This is useful if you have shipments to multiple programs and you need to look at which 
shipments need to be ordered or confirmed with the suppliers or donors.  

Use this report to review shipment status information (including schedules and costs) for a 
selected set of programs. Select a single supplier. Present this report to that supplier to order 
planned shipments, confirm previously ordered shipments, and confirm receipt of shipments 
received from the supplier during the report period. 

From the PipeLine Summary Menu— 

1. Click on the Shipment Order Report button. 

PipeLine displays orders and associated data for the selected programs. Figure 8-4 shows a 
sample of the Shipment Order report screen. By default, the Shipment Order report is set for 
all products and all shipment statuses with a five-year reporting period. 

Figure 8-4—Summary Shipment Order Report screen      
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To limit the report’s scope— 

2. Click on the arrow next to the Select Supplier field, and select a supplier from the 
pull-down menu. 

3. Click on the Select Status field, and select the shipment status you need. 

4. Click on the From field, and type the beginning date of the report. 

5. Click on the Through field, and type the ending date of the report. 

� Always enter a four-digit year (e.g., 2003, 2004, 2005, etc.). 

The Page Breaks Between Status fields enable you to include page breaks between the 
shipment statuses listed in the report (when the report is generated for more than one 
shipment status). 

6. Click on the Page Breaks Between Status field to include page breaks between 
shipment statuses. 

See page 8-11 for information on printing the Shipment Order report. 

Consumption Graph/Export 
The Consumption graph groups consumption data by product ID or method ID. 

Use this graph to compare relative shares and trends of distribution by product or method for 
multiple programs.  

If you choose Method, the colors and legend will indicate what products and what programs 
are represented by each Method ID bar. If you choose Method and Program Detail, you will 
see the relative shares of each program, but not the product.  

This is useful when programs use different but comparable products, so the method 
distinction is more useful than the product distinction. 

From the PipeLine Summary Menu— 

1. Click on the Consumption Graph/Export button. 
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The graph is based on the last 
product/method and period 
updated or displayed. Figure 8-5 
shows the Consumption Graph 
screen, which is displayed after 
the graph is created. Use this 
screen to create graphs for other 
products/methods. 

Graph Type 
This section of the screen 
enables you to determine the 
type of graph you will 
produce. Your options are 
Product or Method. 

Figure 8-5—PipeLine Summary Consumption Graph screen      

2. To create a graph by product, click on the 

arrow next to the Select Product field, and 

select a product from the pull-down menu. 


Or, click on the Method field (under Graph, 
see Figure 8-6). Click on the arrow next to 
the Select Method field, and select a Figure 8-6—Graph options     
method from the pull-down menu to create 
a graph by method. 

When you create a consumption graph by method, the Detail section of the Consumption 
Graph screen becomes active (see Figure 8-6). Product is selected by default, enabling you to 
create a graph for products associated with a selected method. 

To create a graph for all products of a particular method through an aggregation of 
programs— 

3. Click on the Program field (under Detail, see Figure 8-6). 

4. Click on the arrow next to the Select Method field, and select a method from the 
pull-down menu. 

Regardless of the type of graph you choose, select the remaining options. 

By default, the graph includes consumption forecasts. To create a graph that excludes forecast 
data— 

5. Click on the No field (see Figure 8-7). 

6. Click on the arrow next to the Display Results field, and select 
Monthly to display the data by month, or Quarterly to display 
the data by quarter. Figure 8-7—Forecast 

options      
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Figure 8-8—Output window 

The default reporting period is five years (the previous two years, current year, and following 
two years). To change the default reporting period— 

7. Click on the arrow next to the From field, and select the starting year of the report period. 

8. Click on the arrow next to the Through field, and select the last year of the report period. 

See page 8-11 for information on printing the Consumption graph. 

Exporting Summary Consumption Graph Data 
Summary Consumption graph data can be exported for use with Microsoft Excel or other 
analysis software. After you create a consumption graph for a product or method— 

1. Click on the Export button. 

PipeLine displays the Output window (see 

Figure 8-8). 


2. Click on the file type for the export data. 

3. Click on the OK button. 

PipeLine opens another Output window, so you 

can name and save the export file. 


4. Click on the OK button. 


Or, click on the File Name field, and type the new export file name. 


5. Click on the OK button to export and save the Consumption graph. 

6. Click on the Back button to return to the PipeLine Summary menu. 

Couple-Years of Protection (CYP) Graph  
The CYP Graph converts consumption data by the CYP factor associated with a method. 

Use this graph to measure and compare the extent of coverage provided by product or 
method across programs. The CYP factor is based on the percentage of one year where one 
unit of the method would provide one couple with contraception, if used properly.  

You can compare coverage achievement over time between programs despite differences in 
method mix. A social marketing program may distribute more units and more volume and, 
perhaps, more value with methods like condoms and orals. But, a CYP analysis may indicate 
that a clinic NGO or MOH program may achieve more coverage because of the greater CYP 
factors of long-term methods such as Norplant, Depo-Provera, and IUDs. 
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Use this graph to evaluate and monitor relative program coverage or national coverage and 
achievement.  

Creating the CYP Graph 
Create the CYP graph as follows. 


From the PipeLine Summary Menu— 


1. Click on the Couple-Years of Protection (CYP) Graph button. 

Figure 8-9 is a sample PipeLine Summary CYP graph screen. 

Figure 8-9—PipeLine Summary CYP graph screen        

The Display Items field shows the products or contraceptive methods that can be included in 
the graph. 

2. Click on the Method option (Under Graph, see  
Figure 8-10) to create a graph by method. 

Or click on the Product option (Under Graph,  
see Figure 8-10) to create a graph by product. 

Figure 8-10—Graph type 

After you set the graph for products or methods— selection 

3. Click on the product (or method) you want to include. 

To select multiple products (or methods)— 
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4. Hold down the Control key (<Ctrl>) and click on each product or method you 
want to include. 

5. Click on the arrow next to the Display Results field, and select Monthly to 
display the data by month or Quarterly to display the data by quarter. 

6. Click on the arrow next to the From field, and select the starting year of the 
report period from the pull-down menu. 

7. Click on the arrow next to the Through field, and select the last year of the 
report period from the pull-down menu. 

Displaying the Summary CYP Graph 
Use the Display Graph tab to preview the CYP graph before printing it. 

1. Click on the Display Graph tab. 

The CYP graph is created and displayed (see Figure 8-11). 

Figure 8-11—CYP Graph display       

See page 8-11 for information on printing the PipeLine Summary CYP graph. 
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Figure 8-12—Export CYP Data window 

Exporting the CYP Graph 
The Export button enables you to export the data of a completed PipeLine Summary 
CYP graph. After you create a CYP graph, you 
can export the data as follows— 

1. Click on the Export button. 

PipeLine displays the Export CYP Data window 
(see Figure 8-12). Use the options in this window 
to arrange the data in a Microsoft Office Excel 
spreadsheet. 

CYP Graph 
Incorporates the CYP factors into the 
consumption totals for ad hoc reports and graphs. 

FPPMES 
Arranges the data for the Family Planning Program Monitoring and Evaluation System. 

The default is CYP Graph. 

2. Click on the OK button to accept the default. 

Or, click on FPPMES, and click on the OK button. 

PipeLine opens another Output window where you can name and save the export file. 
The default export file name is shown in the File Name field. 

3. Click on the OK button to accept the default. 

Or, click on the File Name field, and type the new export file name. 

4. Click on the OK button to export, and save the Consumption graph. 

5. Click on the Back button to return to the PipeLine Summary menu. 

Previewing and Printing a Report or Graph 
The procedure for printing a PipeLine Summary report or graph is the same regardless of 
the type you choose. To print a completed report or graph— 

1. Click on the Print button to display the report or graph on your screen. 

2. Click on the print icon  to send the report or graph to your default printer. 
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3. Click on the close icon  to return to the previous screen. 

4. Click on the Back button to return to the PipeLine Summary menu. 
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Introduction 
PipeLine’s collection of utilities can be accessed from the Menu Bar. These utilities give you 
access to features that can enhance PipeLine’s usefulness. Sample Figure A-1 shows the 
PipeLine Menu Bar. 

Figure A-1—PipeLine Menu Bar 

PipeLine’s File Utilities 
The File option of the PipeLine Menu Bar enables you 
to add, open, copy, and close program data files. It also 
enables you to display the properties of the current 
program and to exit PipeLine. 

The first four options of the File option’s drop-down 
menu (New, Open, Copy, and Close) are explained in 
section 3 of this guide. 

Figure A-2—File options   

Program Properties 
The Properties option displays basic information about the program file you are currently 
using. 

To display the properties of the current 

program— 


1. Click on the File Menu Bar option. 

2. Click on the Properties option. 

PipeLine displays the Properties window 

(see Figure A-3). 


3. Click on the Close button to close the 

Properties window. 


Figure A-3—Program properties   
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Exiting PipeLine 
You can exit PipeLine at any time. 

To exit PipeLine— 

1. Click on the File Menu Bar option. 

2. Click on the Exit option. 

PipeLine’s Import Utilities 
The Import option of the Menu Bar enables you to import product, consumption, and shipment data. 

Importing Product Data 
PipeLine allows you to either import new product 

data or update product data previously imported. 

Figure A-4 shows the selections available through 

the drop-down menu. 


Figure A-4—Import Product options   

Import New Product Data 

To import new products generated by other procurement systems.— 

1. Click on the Import Menu Bar option. 

2. Click on the Product option. 

3. Click on the New option. 

The Import Product List window is displayed (see Figure A-5—Import Product List window).  

Figure A-5—Import Product List window 

!! Inside the Type box, be sure that the File radio button is selected. The 
functionality for the Web option is currently not available. 
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4. Type the location of the product file you need to import, and click on the OK 
button. 

If you are not sure where the file is located, use the Browse 
button. Click on the Browse button, and use Windows 
Explorer to locate the file you need. Click on the file, and 
Click Open. 

PipeLine displays a warning message if the XML file is not valid for this Country 
Program. 

Never import a file from the A:\ drive. Move the data from the A:\ 
drive to your hard disk, then use the Import Option to select the data. 

After validating the file, PipeLine displays the Product Import Reconciliation window 
(see Figure A-6). 

Figure A-6—Product Import Reconciliation window 

Reconciling Imported Product Data 
The Product Import Reconciliation screen shows a list of all potential products to be 
imported. The Source field is filled with the source of the import data. 

For example: If the data was imported from SCMS, the name is displayed in the 
Source field in the Product Import Reconciliation window (see Figure A-6).  
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The Date field contains the date the import file was created. The Override Default 
Case Size on Import? field identifies if the import values will overwrite the default 
case size in the database. 

5. Deselect “Override Default Case Size in import?” if you do not want the 
default Case Size overwritten with what is in the import file. 

The Category column displays the category for the product in the import file, and the 
Product column displays the Product Code and Product Name for the product values 
in the import file. The next two columns are marked with a check only if a particular 
product in the import file is available from the source of the import file and if it is 
permitted in the country. The final two columns are used to select a product to be 
imported, and to map products to existing PipeLine products, if necessary.  

Products that are available from the source and are permitted in the country � will automatically be selected for import. Also, all products with a code 
that matches a PipeLine product will automatically be mapped; the 
mapping cannot be modified. 

To select a product for import— 

6. Click on the Select column for each product you would like to import into 
PipeLine. 

To associate a product being imported with existing PipeLine products— 

7. Click on the arrow next to a blank data field, and select the PipeLine 
product that corresponds to the imported product. 

8. Repeat the process for each product that needs to be associated with an 
existing PipeLine product. 

Mapping a new product to an existing PipeLine product will not 
import it. You must also check the Select column in the new 
product’s row. 

After you select the products to be imported and associate the product where 
applicable— 

9. Click on the OK button to complete the import. 

After the selected products are imported into PipeLine, the Import Report will be 
displayed. This report shows all the products that were imported, and also lists any errors 
for the products that were selected but not imported. Using the toolbar, you can export 
the report to Word, Excel, or PDF. 
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!! The system does not save these reports, so is strongly recommended that 
you either export or print the report (before closing it). 

After the report is closed, you will return to the main screen and will be able to view 
the newly imported products in the Product form. 

Update Product Data 

To update information, including cost data, for products previously imported from other 
procurement systems.— 

1. Click on the Import Menu Bar option. 

2. Click on the Product option. 

3. Click on the Update option. 

The Update Product List window is displayed (see Figure A-7).  

Figure A-7—Update Product List window 

!! Inside the Type box, be sure that the File radio button is selected. The 
functionality for the Web option is currently not available. 

4. Type the location of the product file you need to import, and click on the OK 
button. 

If you are not sure where the file is located, use the Browse 
button. Click on the Browse button, and use Windows 
Explorer to locate the file you need. Click on the file, and 
click Open. 

5. Deselect “Override Default Case Size in import?” if you do not want the 
default Case Size overwritten with what is in the import file. 
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PipeLine displays a warning message if the XML file is not valid for this Country 
Program. 

Never import a file from the A:\ drive. Move the data from the A:\ 
drive to your hard disk, then use the Import Option to select the data. 

PipeLine will automatically update information for all corresponding products. After the 
products are updated into PipeLine, the Import Report will be displayed. This report 
shows all the products that were updated. Using the toolbar, you can export the report to 
Word, Excel, or PDF. 

!! The system does not save these reports, so is strongly recommended that 
you either export or print the report (before closing it). 

After the report is closed, you will return to the main screen, and will be able to view the 
newly updated products in the Product form. 

Importing Consumption Data 
PipeLine enables you to import forecast and 
actual consumption data generated by other 
logistics management systems (see Figure A-8). 

Figure A-8—Import Consumption options 

Import Forecast Consumption 
Data 

To import forecast consumption data.— 

1. Click on the Import Menu Bar option. 

2. Click on the Consumption option. 

3. Click on the Forecast option. 
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PipeLine displays the Import Forecast Data window so you can select the data files to 
import (see Figure A-9). 

Figure A-9—Import Forecast Data window 

!! Inside both Type boxes be sure that the File radio button is selected. The 
functionality for the Web option is currently not available. 

4. Type the location of the Forecast Data file you need to import. 

If you are not sure where the forecast data file is located, 
use the Browse button. Click on the Browse button, and use 
Windows Explorer to locate the file you need. Click on the 
file and click Open. 

5. Type the location of the Product List file you need to import. 

If you are not sure where the product list file is located, use 
the Browse button. Click on the Browse button, and use 
Windows Explorer to locate the file you need. Click on the 
file and click Open. 

6. Click OK. 

PipeLine displays a warning message if the XML files are not valid for this Country 
Program. 
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Never import a file from the A:\ drive. Move the data from the A:\ 
drive to your hard disk, then use the Import Option to select the data. 

After validating the file, PipeLine displays the Forecast Data Import Reconciliation 
window (see Figure A-10). 

Figure A-10—Forecast Data Import Reconciliation window 

Reconciling Imported Forecast Consumption Data 
The Forecast Data Import Reconciliation screen shows a list of all potential forecast 
data and products to be imported. The Source field displays the source of the import 
data. 

For example: If the data were imported from SCMS, the name is displayed in the 
Source field on the Forecast Data Import Reconciliation window (see Figure 
A-6—Product Import Reconciliation window). 

The Date field displays the date on which the import file was created. The Override 
Default Case Size on Import? field identifies if the import values will overwrite the 
default case size in the database. 

7. Deselect “Override Default Case Size in import?” if you do not want the 
default Case Size overwritten with what is in the import file. 

The Product column displays the Product Code and Product Name for the products in 
the imported forecast data file. The Select field is used to select which product 
forecast consumption data will be imported. The final two columns are used to map 
forecast data file products to the product displayed in the selected product list and to 
existing PipeLine products, if necessary. 

A-8 



APPENDIX A PIPELINE UTILITIES 

All products that match a product in either the product list file or in � PipeLine will automatically be mapped; the mapping cannot be 
modified. 

To select consumption data for import— 

8. Click on the Select column for each product whose consumption data you 
would like to import into PipeLine. 

To associate consumption data to be imported with product in the Product List— 

9. Click on the arrow next to a data field in the SCMS Product column, and 
select the product that corresponds to the imported consumption data. 

10.Repeat the process for each product that needs to be associated with a 
product in the Product List. 

Mapping consumption data to a product in the Product List will not 
import it. You must also check the Select column in the 
corresponding row to import it. 

To associate a product being imported with existing PipeLine products— 

11.Click on the arrow next to a blank data field, and select the PipeLine 
product that corresponds to the imported consumption data. 

12.Repeat the process for each product that needs to be associated with an 
existing PipeLine product. 

Mapping a new product to an existing PipeLine product will not 
necessarily import it.  You must also check the Select column in the 
corresponding row to import it. 

After you select the products to be imported and associate the products where 
applicable— 

13.Click on the OK button to complete the import. 
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If you check the Select column for a product and then leave both the SCMS � Product and PipeLine Product columns blank, a brand new product in 
PipeLine will be created with this product’s forecast consumption data. 

If you check the Select column for a product and then select a SCMS 
Product but not a PipeLine Product, the SCMS Product will be imported 
into PipeLine and all corresponding forecast consumption data will be 
associated with this SCMS Product’s name. 

If you check the Select column for a product and then select a SCMS 
Product and a PipeLine Product, the SCMS Product will be imported into 
PipeLine replacing the existing PipeLine Product and all corresponding 
forecast consumption data will be associated with this new SCMS 
Product’s name. 

If you check the Select column for a product and then select a PipeLine 
Product but not a SCMS Product, the forecast consumption data will be 
associated with this PipeLine Product’s name. 

After the selected consumption data is imported into PipeLine, the Import Report will 
be displayed. This report shows all the products which were imported with associated 
forecast consumption data, and also lists any errors for the products that were selected 
but not imported. Using the toolbar, you can export the report to Word, Excel, or PDF. 

!! The system does not save these reports, so is strongly recommended that 
you either export or print the report (before closing it). 

After the report is closed, you will return to the main screen, and will be able to view 
the newly imported products and consumption data. 

Import Actual Consumption Data 

To import actual consumption data— 

1. Click on the Import Menu Bar option. 

2. Click on the Consumption option. 

3. Click on the Actual option. 

The Import Consumption Data window is displayed (see Figure A-11). 

Figure A-11—Import Consumption Data window 
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4. Type the location of the file you need to import, and click the OK button. 

If you are not sure where the file is located, use the Browse 
button. Click on the Browse button, and use Windows 
Explorer to locate the file you need. Click on the file, and 
click Open. 

PipeLine displays a confirmation message, so you can confirm that the selected data can be 
imported. 

Never import a file from the A:\ drive. Move the data from the A:\ 
drive to your hard disk, then use the Import Option to select the 
data. 

After you locate and import the file, PipeLine displays the Import Reconciliation window  
(see Figure A-12). 

Figure A-12—Import Reconciliation window 

Reconciling Imported Data 
The imported actual consumption data can be reconciled. 


The Source to Reconcile field displays the source of the import data. 
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For example: If the data were imported from a tool such as Supply Chain 
Manager, the name of the tool is displayed in the Select Source To Reconcile field 
on the Import Reconciliation window (see Figure A-12). 

If the entry in the Select Source to Reconcile field does not reflect the imported data’s 
origin— 

5. Click on the arrow next to the Select Source to Reconcile field, and select 
the import data’s source from the pull-down menu. 

The Consumption Data Source field identifies the source of consumption data (e.g., 
reports, estimates, etc.). 

6. Click on the arrow next to the Consumption Data Source field and select 
the consumption data source from the pull-down menu. 

The Stock Data Source field identifies the source of stock level data (e.g., physical inventories, 
reports, etc.). 

7. Click on the arrow next to the Stock Data Source field, and select the 
stock data source from the pull-down menu. 

After you select the appropriate data sources, you must associate the products of the 
imported data set with products in 
PipeLine. 

For example: Figure A-13 shows that 
the imported product CNT003—IUD 
Multiload is associated with PipeLine 
product CT38—Copper T, 380. 

To associate imported products with 
PipeLine products— 

8. Click on the arrow next to a blank data field, and select the PipeLine 
product that corresponds to the imported product. 

9. Repeat the process until all imported products are associated with 
corresponding PipeLine products. 

After you associate all products— 

10.Click on the OK button to reconcile the data. 

Figure A-13—Product association options    
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Reconcile Consumption Data 

The Reconcile option of the Consumption Menu Bar option performs the same operation 
as the reconcile step of the Import Actual Consumption Data function. To reconcile 
actual consumption data— 

1. Click on the Import Menu Bar option. 

2. Click on the Consumption option. 

3. Click on the Reconcile option. 

See Reconciling Imported Data on page A-11 for instructions on reconciling PipeLine data. 

Importing Shipment Data 
The Shipment Import option of the Import Menu Bar 
option becomes available after you create and save a 
new program. This option enables you to import data 
from other commodity management systems. 

Figure A-14—Import Shipment options   

You will only be able to use this option if you have access to an exported � data file, and the program you are currently working with does not have 
any USAID shipments associated with it. 

This option can only be used once per program. 

To import shipment data— 

1. Click on the Import Menu Bar option. 

2. Click on the Shipment option. 

3. Click on the Initial option. 

A window is displayed, showing the file(s) available for import. Files are identified by the .d 
extension (e.g., woo1120.d, 0201020.d, 03021r00.d, etc.). 

4. Click on the file you need to import. 

5. Click on the Open button to import the file. 

A window is displayed, asking if the file you selected contains SCMS shipments. 
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6. Click Yes if the file being imported contains SCMS shipments, otherwise click No. 

The selected data is imported into PipeLine. 

PipeLine’s Export Utilities 
The Export option of the Menu Bar lets you export 
program data (see Figure A-15). 

Figure A-15—Export options 

Exporting Program Data 
To export program data— 

1. Click on the Export Menu Bar option. 

2. Click on the Program Data (XML) option. 

PipeLine displays the Save Output Data To window so you can save the current program data 
as an XML file (see Figure A-16). The default file name is created by PipeLine based on the 
Program Code and the date. 

Figure A-16—Save Output Data To window 
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If Export -> Program Data (XML) is selected by accident, 
you can go back to the previous screen by clicking the 
Cancel button on the Save Output Data To screen. 

3. Click on the Save button to accept the default file name. 

Or, type a new file name and click on the Save button. 

Never save the data to your A:\ drive. 

PipeLine displays the Program Data Export (XML) window as notification that the export of 
program data was successfully completed. This window shows the location of the newly 
created file. 

4. Click OK. 

Your previous location in PipeLine is redisplayed after the data is saved. 

PipeLine’s Tools Utilities 
The PipeLine Tools Menu Bar option lets you change 
PipeLine’s display language, access the PipeLine 
Summary module, compact the PipeLine database, and 
choose a PDF printer. 

Figure A-17—Tools options    

Changing the Display Language 
PipeLine supports English, Spanish, French, Arabic, and Portuguese. To change the display 
language at any time, use the Language option of the Tools Menu Bar option. This temporary 
change remains in effect for the duration of the session. 

Only PipeLine’s screens, buttons, and messages are converted to the � selected language. Data entered into PipeLine remains in the language it 
was entered in. 

For example: Data entered into PipeLine in English remains in 
the English language. 

This, however, does not prevent you from entering data in any of 
PipeLine’s supported languages. 

To change the language of the current session— 
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1. Click on the Tools Menu Bar option. 

2. Click on the Language option. 

The Language pop-up menu is displayed 
(see Figure A-18). 

3. Click on the desired language. 

PipeLine’s screens, buttons, etc., are displayed in the Figure A-18—Language options     

selected language until the current session is closed. 

Accessing the Summary Module 
The PipeLine Summary module (only available in English) is intended for program managers 
and/or consultants responsible for managing multiple programs tracked by PipeLine. It 
aggregates PipeLine data from selected programs, and arranges the data so it can be 
presented in a graph or report. 

To access the PipeLine Summary Module— 

1. Click on the Tools Menu Bar option. 

2. Click on the PipeLine Summary option. 

See Section 8, PipeLine Summary, for detailed information on the PipeLine Summary 
Module. 

Compacting the PipeLine Database 
PipeLine provides a function to compact the current program file,  often referred to as 
compacting the backend. The Compact Backend option is useful if you use PipeLine on a 
laptop and are running out of disk space. 

To compact the PipeLine database— 

1. Click on the Tools Menu Bar option. 

2. Click on the Compact Backend option. 

PipeLine compacts the database and displays a confirmation message. 

3. Click on OK. 

Choose PDF Printer 
The Choose PDF Printer option enables you to define your PDF writer so you can create PDF 
PipeLine graphs and reports within the software (see Figure A-19). 
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To choose your PDF writer— 

1. Click on the Tools option of 

the Pipeline Menu Bar. 


2. Click on the Choose PDF 

Printer option in the pull-

down menu. 


A window is displayed, showing the printers available on your machine.  

3. Click on the arrow next to the Printers field, and select the PDF writer from the 
pull-down menu. 

4. Click on the Set PDF Writer button to set the printer. 

PipeLine’s Help Utility 
The PipeLine Help utility provides 
access to PipeLine’s online help system. 
It also provides access to PipeLine’s 
About feature. This feature lets you see 
what version of PipeLine you are 
running. Figure A-20 shows an example Figure A-20—Help options     

of the Help drop-down menu. 

PipeLine’s About Feature 
The About PipeLine option of the Help drop-down menu displays the PipeLine version you 
are using. 

To view the version of PipeLine you are 
currently using— 

1. Click on the Help option on the 

PipeLine Menu Bar. 


2. Click on About PipeLine. 

PipeLine displays the About window (see 
Figure A-21). 

3. Click on the Close button to close the 

About window. 


Figure A-19—Select PDF Writer from list     

Figure A-21—PipeLine’s About window 
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APPENDIX B TERMS AND 
DEFINITIONS 

INTRODUCTION 

The following terms are used in PipeLine: 

PIPELINE TERM DEFINITION 

Above Maximum Stock level is higher than required for the maximum months 
desired for the program. 

Action Required Needed procurement action based on lead times and shipment status. 

Active Product Products currently in use. PipeLine does not monitor or include 
in multi-product reports any products that are not marked 
“active.” 

Adjustment Date Date on which an inventory adjustment occurred or is projected 
to occur. 

Backup Saves PipeLine program data files to a specified location. 

Basic Unit (BU) 
UOM 

UOM is used to count the products at the usage level. This may or 
may not be the same as the Pack UOM: for example, bottle, 
tablet, test, box, ml, gram, co-pack, or pair of gloves. 

Beginning Balance Stock quantities equal to ending balance for previous period. 

Below Minimum Stock level is lower than required for minimum months desired 
for the program. 

Case Size Minimum shipping unit quantity. 

Category Group where products and other categories can be assigned. If a 
category has products assigned directly to it, then it is also a type. 

Case Qty Number of packs per carton. 

Case UOM Minimum shipping unit: for example, carton, case, shipping 
carton, carton of gloves. 
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PIPELINE TERM 

Code 

Confirm Shipment 
Ordered 

Confirm Shipment 
Dispatched 

Confirm Shipment 
Received 

Consumption, 
Actual 

Consumption, 
Forecast 

CPT 

CYP 

Data Source 

Date of Next 
Action 

Date of Problem 

Default Supplier 

Desired End of 
Year Stock [in 
Months] (DEOYS) 

Ending Balance 

Inventory Adjustment 

DEFINITION 

Identification code used by the database but usually not found in 
the reports. 

Indicates a planned shipment should be ordered by the  
action date. 

Indicates an ordered shipment should be shipped by the  
action date. 

Indicates a shipped shipment should have been received by the 
action date. 

Product quantity estimated or known to have been dispensed to 
clients for any number of months. 

Product quantity forecasted or projected to be dispensed to 
clients for any number of months. 

Contraceptive procurement tables. USAID’s format for 
computation of calendar year quantities required and generation 
of data for USAID’s planning requirements. 

Couple-years of protection. The percentage used to calculate the 
amount of pregnancy protection afforded by a contraceptive 
product or method for one year. This only applies to 
contraceptives. 

Information source for each primary record. 

Date the procurement status of a shipment should change (for 
example, from Ordered to Shipped), based on lead times. 

Date an indicated problem is projected to occur or did occur. 

Product’s normal supplier. 

Used by the CPT Report to calculate requirements based on the 
amount, in months of stock, the product should have at the end 
of the year. 

Beginning period’s balance computed by subtracting 
consumption, adding shipments received (if any), and adding or 
subtracting inventory adjustments for the period. 

Event other than Consumption or Shipments that changes the 
program’s inventory balance. This is typically a loss (for example, 
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PIPELINE TERM DEFINITION 

expiry, damage, theft) or transfer (out of or into the program, 
such as a loan from or to another program). 

Inventory Date Date an inventory count was made. 

Inventory Count Physical inventory quantity record that creates an adjustment to 
recalculate ending balance. 

Lead Time, Months needed for procurement actions. Estimated dates are 
Supplier based on these lead times. 

Lead Time, Months needed for procurement actions. Procurement action 
Program dates for needed shipments are based on these lead times. 

Estimated shipment dates are based on these lead times if 
supplier lead times are not in PipeLine. 

Lead Time Dates, Dates entered for order and/or shipping. When a shipment’s 
Shipment status is changed from planned to ordered or ordered to shipped, 

the date the status changed must be entered. These dates 
override estimated lead time dates for a particular shipment. 

Maximum Maximum level of stock desired by the program, including storage 
facilities and service delivery points, expressed as the number of 
months the quantity is expected to last. Exceeding this level could 
result in problems related to high storage costs, exceeding storage 
capacities, and/or loss of product due to expiry or storage conditions. 

Method Category that has a CYP factor defined for it. If products are 
assigned to a Method, then the Method is also a Type and CYP 
graphs will be available for the products assigned to it. 

Minimum Minimum stock level desired by the program, including storage 
facilities, expressed as the number of months the quantity is 
expected to last. 

Needed to Reach Stock quantity needed in a month to bring the ending balance up 
Max to the maximum. 

Needed Quantity needed to reach maximum in a month for which the 
ending balance is projected to fall below minimum. 

Order to Ship Estimated lead time (in months) expected from the time a 
shipment is ordered to when it is shipped. 

Ordered Shipment for which funds have been allocated, the product has 
been identified as available, and the order has been placed. 
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PIPELINE TERM DEFINITION 

Parent Category Category that another Category is assigned to. Each Category 
can have only one Parent Category. 

Pack Size Number of BUs per pack. When the UOM is the same as the 
BU, the pack size is equal to one. 

Pack UOM UOM is used when ordering and counting the products at the 
stockkeeping level: for example, bottle, co-pak, box, kit, carton, 
case, or box of gloves. 

Permitted in At least one manufacturer has importation permission for a 
Country country for a specified product. 

Plan Shipment Indicates that the ending balance for the month is projected to 
fall below the minimum. Thus, the quantity needed to reach the 
maximum should arrive as a shipment during the month. 

Plan to Order Estimated lead time (in months) expected from the time a 
shipment is planned to when it is ordered. 

Planned Shipment whose quantity, supplier, and desired receipt date 
have been determined and entered into PipeLine. 

Product Specific commodity to be monitored and procured. 

Program Refers to the organization that owns/manages the logistics 
system and dispenses the products to clients, such as the 
Ministry of Health or the Family Planning Association. 

Received Shipment that has been received by the program and made 
available for consumption. 

Ship to Receive Estimated number of months expected from the time a shipment 
is shipped to the time the program receives it. 

Shipped Shipment that has been dispatched to the program but not yet received. 

Shortfall/Surplus Ending balance quantity that is below the minimum or above the 
maximum. 

Stockout Ending balance is zero. 

Stock in Months Ending balance divided by the average monthly consumption. 
Average monthly consumption is calculated by adding the 
month’s consumption to the following two months of 
consumption. The resulting sum is divided by three. 
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PIPELINE TERM DEFINITION 

Supplier Donor or other source that supplies a product to a program. 

Surplus: Change Indicates that receipt of this shipment will cause the ending 
balance for the month to rise above maximum. 

Trend Analysis Report showing consumption data in PipeLine and the trend of 
the actual consumption data. 

Type Category that has products assigned to it. Each product can be 
assigned to only one type. 

UOM A unit of measure. 

Value, Product Per unit value of a product. 
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